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Product description

The lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX (Cat. No. A51307) is a next-generation
sequencing (NGS) assay to enable research and surveillance of the SARS-CoV-2 virus, including
variants of concern. The assay includes the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel, which
contains variant-tolerant primers to broaden and improve the coverage for variants of concern and
increase the sensitivity of the panel to enable detection from lower viral titer samples.

The assay enables complete genome sequencing of the SARS-CoV-2 virus on the Genexus™ Integrated
Sequencer. The Genexus™ Integrated Sequencer performs library preparation, sequencing, analysis,
and reporting in an automated sample-to-result workflow.

The lon AmpliSeq™ SARS-CoV-2 Insight Research Panel - GX includes the following features.
* >99% coverage of the SARS-CoV-2 genome, covering all potential serotypes
* Internal human gene expression controls included to verify sample quality
* Samples with Ct values >28 can be used to prepare libraries

Robust SARS-CoV-2 variant calling and reporting with plugin support in Genexus™ Software

If you are a new user, or you need detailed descriptions of all features of the Genexus™ Integrated
Sequencer and Genexus™ Software, see the following resources available at thermofisher.com.
* Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910)

* Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409) or Genexus™ Software Help (available
in the software)

Software compatibility

The lon AmpliSeg™ SARS-CoV-2 Insight Research Panel is compatible with Genexus™ Software 6.8 and
later. We recommend that you update your software to the latest available version before using this kit.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide 7
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Contents and storage

The lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX (Cat. No. A51307) includes the 2-pool
RNA panel (SARS-CoV-2 Insight Panel - Pool 1 and SARS-CoV-2 Insight Panel - Pool 2), Genexus™
Strip 1, and Genexus™ Strip 2-AS. The contents of each kit are sufficient for 16 samples. Each primer
pool in the panel is provided in 8 pairs of tubes, where each tube pair contains one tube with primers

in position 1 and one empty uncapped tube in position 2. One 8-strip pack containing Genexus™ Strip 1
and Genexus™ Strip 2-AS is provided with each kit.

The lon AmpliSeg™ SARS-CoV-2 Insight Research Panel — GX consists of two primer pools that target
237 amplicons specific to SARS-CoV-2 and several human gene expression controls. With an amplicon
length range of 125-275 bp, the panel provides >99% coverage of the SARS-CoV-2 genome (~30 kb),
and covers all potential serotypes.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX (Cat. No. A51307)

Contents Carrier color | Number of samples | Amount | Part No. Storage

lon AmpliSeq™ SARS-CoV-2 Insight Research Panel - GX

SARS-CoV-2 Insight Panel - Pool 1 Magenta | 16 (4 samples/tube) | 4 tubes | A51301 | -30°C to —-10°C
(position 1, white cap)

SARS-CoV-2 Insight Panel - Pool 2 Pale green | 16 (4 samples/tube) | 4 tubes
(position 1, white cap)

Genexus™ Library Strips 1 and 2-AS (Cat. No. A40252)

Genexus™ Strip 1 Light red 16 8 strips | A46812 2°Cto 8°C

Light blue 16 8 strips | A46813 |-30°C to -10°C
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Required materials not supplied for use with the Genexus™

Integrated Sequencer

Genexus™ Integrated Sequencer reagents and supplies can be ordered as kits and starter packs. In
addition, most consumables can also be ordered individually. This sectiion provides information about

the various ordering options.

Note: Consumables that have catalog numbers are orderable. Components that have part numbers

cannot be ordered individually.

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates
that the material is available from fisherscientific.com or another major laboratory supplier. Catalog
numbers that appear as links open the web pages for those products.

Genexus™ Barcodes AS

lon Torrent™ Genexus™ Barcodes AS are supplied in plates containing 32 or 48 dual barcodes per
plate. The barcodes can be ordered as a set of three 32-barcode plates (Cat. No. A40257), or ordered

individually.
Item Label color Cat. No. Quantity Storage
Genexus™ Barcodes 1-96 AS Blue A40257 3 plates
Genexus™ Barcodes 1-32 AS Blue A40258 1 plate
Genexus ™ Barcodes 1-32AS . |*°
B
Genexus™ Barcodes 33-64 AS Blue A40259 1 plate
15°C to 30°C

Genexus™ Barcodes 65-96 AS Blue A40260 1 plate
Genexus™ Barcodes 1-48 AS Blue A54129 1 plate
Genexus™ Barcodes 49-96 AS Blue A54130 1 plate
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Genexus™ Templating Strips 3-GX5™ and 4

lon Torrent™ Genexus™ Templating Strips 3-GX5™ and 4 (Cat. No. A40263) are ordered as kits with
8 pairs of strips per kit.

Component Carrier color | Part No. | Quantity per kit Storage

Genexus™ Strip 3-GX5™ Brown A46815 8 strips 2°C to 8°C

Yellow A46816 8 strips -30°C to -10°C

Genexus™ Pipette Tips

The lon Torrent™ Genexus™ Pipette Tips (Cat. No. A40266) are ordered in packs of 12 racks each. The
number of pipette tip racks that are required for your experiment depends on the number of samples
included in the run.

Item Cat. No. Quantity Storage

Genexus™ Pipette Tips A40266 12 racks 15°C to 30°C
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GX5™ Chip and Genexus™ Coupler

Chapter 1 Product information @
Required materials not supplied for use with the Genexus™ Integrated Sequencer "

The GX5™ Chip and Genexus™ Coupler (Cat. No. A40269) are ordered as a set that contains 2 chips

and 2 couplers, sufficient for up to 8 sequencing runs.

Component Part No. Quantity Storage
GX5™ Chip 100081364 2 chips 15°C to 30°C
ion torrent 6xAOXO+%
100081252 2 couplers

Genexus™ Sequencing Kit

The lon Torrent™ Genexus™ Sequencing Kit (Cat. No. A40271) provides reagents and solutions sufficient

to sequence up to 2 full chips.

Component Part No. Quantity Storage
Genexus™ Cartridge A40272 2 cartridges -30°C to -10°C
Genexus™ Bottle 2 A40273 4 bottles 15°C to 30°C
Genexus™ Bottles 1 and 3 A40274 2 bottles each
(4 bottles total)

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide
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Genexus™ Conical Bottles

Genexus™ Conical Bottles (Cat. No. A40275) are installed in the sequencing reagents bay and serve as
reservoirs for nucleotide reagent dilutions. For information on when and how to replace the bottles, see
the Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

Component Quantity Storage
Genexus™ Conical Bottles 5 bottles 15°C to 30°C
Genexus™ Integrated Sequencer
Components Cat. No.
Genexus™ Integrated Sequencer A45727
General laboratory supplies and reagents
Item Source
MicroAmp™ EnduraPlate™ Optical 96-Well Clear Reaction Plates with Barcode 4483352, 4483354
Thermo Scientific™ Adhesive PCR Plate Foils AB0626
Microcentrifugel'] MLS
2-, 20-, 200-, and 1,000-pL pipettes and appropriate filtered tips MLS
Nuclease-free microcentrifuge tubes, 1.5-mL or 1.7-mL MLS
Vortex mixer with a rubber platform MLS
Gloves, powder-free nitrile MLS
Ice buckets and ice -
Nuclease-free water, molecular biology grade MLS
Isopropyl alcohol, 70% solution MLS
Wipes, disposable lint-free MLS
(Optional) Uninterruptible Power Supply (UPS)! MLS

12

' Must fit standard 0.2- and 1.5-mL microcentrifuge tubes and generate 15,000 x g. To convert the RPMs of your centrifuge to RCF in
units of gravity, see tools.thermofisher.com/content/sfs/brochures/TR0040-Centrifuge-speed.pdf.

] For laboratories that experience frequent power outages or line voltage fluctuations, we recommend that you use an uninterruptible
power supply that is compatible with 2500 W output or higher.
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Recommended materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

Item

Source

Recommended additional equipment

One of the following Applied Biosystems™ real-time PCR instruments:
® 7500 Real-Time PCR System
e 7900HT Fast Real-Time PCR System!(!]
* StepOne™ Real-Time PCR System
* StepOnePlus™ Real-Time PCR System
* ViiA™ 7 Real-Time PCR System
¢ QuantStudio™ 3 Real-Time PCR System
¢ QuantStudio™ 5 Real-Time PCR System
* QuantStudio™ 7 Flex Real-Time PCR System
* QuantStudio™ 12K Flex Real-Time PCR System

Various

96-well plate centrifuge

MLS

Invitrogen™ Qubit™ 4 Fluorometerl?

Q33238

Recommended for nucleic acid isolation

Applied Biosystems™ MagMAX™ Viral/Pathogen Nucleic Acid Isolation Kit

A42352 or A48310

Recommended for nucleic acid quantification

Invitrogen™ Qubit™ dsDNA HS Assay Kit (DNA)

Q32851, Q32854,

Invitrogen™ Qubit™ RNA HS Assay Kit (RNA)

Q32852, Q32855

Applied Biosystems™ TagMan™ RNase P Detection Reagents Kit 4316831
Recommended for SARS-CoV-2 Quantification

TagPath™ COVID-19 Combo Kit A47814
Recommended for RNA dilution

THE RNA Storage Solution AM7000

[ Supported but no longer available for purchase.
[l Invitrogen™ Qubit™ 2.0 Fluorometer or later are supported.
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SARS-CoV-2 positive controls

SARS-Cov-2 positive controls are available from the following suppliers.

Supplier ltem Cat. No.

AcroMetrix™/Thermo Fisher Scientific | AcroMetrix™ SARS-CoV-2 Control 954517

(RUO) 954519

AcroMetrix™ Coronavirus 2019
(COVID-19) RNA Control (RUO)

American Type Culture Collection SARS-CoV-2 External Control Kit ATCC® MP-32™
https://www.atcc.org

BEI Resource Repository SARS-CoV-2 isolates Various catalog numbers
https://www.beiresources.org

Twist BioScience Twist Synthetic SARS-CoV-2 RNA 103086; various catalog
https://www.twistbioscience.com | Controls (1-7) numbers for individual
controls
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Workflow overview: nucleic acid sample to results

The following workflow outlines key steps when using the lon AmpliSeq™ SARS-CoV-2 Insight Research
Panel — GX to analyze SARS-CoV-2 samples, from sample preparation to data analysis.

lon AmpliSeg™ SARS-CoV-2 Insight Research Panel — GX

Create an assay (page 25)

System-installed assays that are specifically configured for low- and high-titer
sample types are available in Genexus™ Software. You can use the system-
installed assays in your run plan without change. If you want to modify any
assay settings, contact support for help in editing a system-installed assay.

Enter samples (page 27)

Enter samples in Genexus™ Software to assign sample names and provide
other information such as sample collection date. AR

Plan a run (page 36)

Run plans created in Genexus™ Software contain all of the settings that are
used in library preparation, templating, sequencing, and analysis, including
sample information and plate location, assays, and barcodes.

Dilute the samples and load the sample plate
(page 42)

Dilute your samples, if needed, then load the sample plate.

Load the sequencer and start a run (page 44)

Follow the step-by-step instructions on the sequencer touchscreen to load the
sample plate and consumables in the Genexus™ Integrated Sequencer.

Review data and results in the Genexus™ Software
(page 57)

View variant calls and visualize results in Genexus™ Software.

U & "%
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Before first use—Download plugins and assay files

IMPORTANT!
. If the computer running Torrent Suite™ Software is not connected to the network, you must manually

upload the SARS-CoV-2 plugins and Run plan templates. Contact support for help.

. Do not restart your computer when downloading and installing plugin and assay files.

You must download or import the following objects.

Plugin ZIP files
Assay ZIP file

Download plugins

You must download the following files from Thermo Fisher™ Connect Platform.

1.

2.

3.

16

Sign in to Thermo Fisher™ Connect Platform (thermofisher.com/connect).
In the Applications bar, click ::.

In the AppConnect screen, in the Resource Libraries pane, click Plugins.

Note: Plugins are downloaded from the Plugins store on Thermo Fisher™ Connect Platform and
not the Genexus™ Software section of Thermo Fisher™ Connect Platform.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide
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4. Find the following files in the list.

ZIP file Files in ZIP file

SARS_CoV_2__Insight_Research_Plugin_Package_ e generateConsensus

in[1
GenexusSoftware.zipl' e SARS_CoV_2_annotateSnpEff
e SARS_CoV_2_controlStat

SARS_CoV_2_lineagelD_5.16.0.10-20210623.zip!"] SARS_CoV_2_lineagelD_5.16.0.10-20210623

GX_SARS_CoV_2_lineagelD_20210623_ Dependency packages for
dependency.zipl?! SARS_CoV_2_lineagelD_5.16.0.10-20210623

[ Available for Genexus™ Software version 6.2.1 and later.
[ Available for Genexus™ Software 6.6.0 and later.

5. Click #% in the row of each plugin to download the plugin to your local storage.

6. Click < to return to the AppConnect screen.

Download assay definition files

You must download the following files from Thermo Fisher™ Connect Platform.

1.

2.

5.

6.

Sign in to Thermo Fisher™ Connect Platform (thermofisher.com/connect).

In the Applications bar, click :.
In the AppConnect screen, in the Resource Libraries pane, click lon Torrent Genexus.

Find SARS-CoV-2 Insight Research Assay in the list, then in the Download column, click &8.
The following assays are included in the ZIP file for SARS-CoV-2 Insight Research Assay.

* SARS-CoV-2 Insight Research Assay

* SARS-CoV-2 Insight LowTiter Research Assay

Click in the row of each plugin to download the plugin to your local storage.

Click < to return to the AppConnect screen.

Import plugins and assay definition files

Contact local field support for assistance to import and upload plugins and assay definition files to
Genexus™ Software.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide 17


https://www.thermofisher.com/connect

=98 Chapter 2 Before you begin
Procedural guidelines

[0 ]

Procedural guidelines

Use only the reagents and supplies that have been verified for the lon AmpliSeg™ SARS-CoV-2
Insight Research Panel — GX. For a list of verified reagents and supplies, see “Required materials
not supplied for use with the Genexus™ Integrated Sequencer” on page 9 and “Recommended
materials” on page 13.

Use good laboratory practices to minimize cross-contamination of products. Keep all tubes sealed
until immediately before loading onto the Genexus™ Integrated Sequencer.

Use controls to identify or rule out reagent contamination. For a list of verified controls, see
“SARS-CoV-2 positive controls” on page 14.

Minimize freeze-thaw cycles of the SARS-CoV-2 Insight Panel - Pool 1 and SARS-CoV-2 Insight
Panel - Pool 2 tubes. Thaw only the number of panel tubes that are required for a given experiment
and keep the thawed panels at 4°C until ready to use. Store unused panels at —30°C to -10°C.

Note: One pair of primer pool tubes (SARS-CoV-2 Insight Panel - Pool 1 and SARS-CoV-2 Insight
Panel - Pool 2) is sufficient for sequencing 4 samples.

Do not store the SARS-CoV-2 Insight Panel - Pool 1 and SARS-CoV-2 Insight Panel - Pool 2,
Genexus™ Strip 1, and Genexus™ Strip 2-AS on the Genexus™ Integrated Sequencer for more than
24 hours before starting an instrument run.

Before each use of the kit

Thaw assay reagents as indicated:

Thaw SARS-CoV-2 Insight Panel - Pool 1 and SARS-CoV-2 Insight Panel - Pool 2 on ice or at
4°C for at least 30 minutes and keep on ice until immediately before loading onto the Genexus™
Integrated Sequencer.

Equilibrate Genexus™ Strip 1 and Genexus™ Strip 3-GX5™ at room temperature for at least
30 minutes before loading onto the Genexus™ Integrated Sequencer.

Thaw Genexus™ Strip 2-AS and Genexus™ Strip 4 on ice or at 4°C for at least 30 minutes and keep
on ice until immediately before loading onto the Genexus™ Integrated Sequencer.

IMPORTANT! Ensure that the strip contents are completely thawed before installing in the sequencer.

When thawed, gently tap tubes and strips on the benchtop to remove any bubbles and collect the
contents at the bottom of each tube. For information about preparing all reagents and consumables for
loading onto the instrument, see “Before you begin” on page 44.

Note: If tapping fails to dislodge a bubble, you can dislodge large bubbles using the technique that is
described in “Before you begin” on page 44.

18
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About Genexus™ Software

About Genexus™ Software

Genexus™ Software provides menus to help you add, select, and manage samples, libraries, runs, and
assays. You can also view and manage sequencing results, and manage software settings.

s

Genexus | len Torrent Dashboard Samples Runs Results Assays yiil 83

Samples / Manage Samples
Filter Samples by... = TP Manage Ta; + mpl ‘ Columns ~ |
Selected Samples:1 <& Clear ¢F Edit [ Copy 10 Delete [ Export P AssignTags  + Prepare Library Batch
= Sample Name T Tags T CreatedOn  + T Application Category T Cancer Stage T Sample Type

LibSample3s4 2021-05-13 11:05 Cancer Primary Cerebrospinal Fluid (CSF)
LibSample383 2021-05-13 11:05 Cancer Primary Cerebrospinal Fluid {CSF)
LibSample3g2 2021-05-1311:05 Cancer Primary Cerebrospinal Fluid (CSF)

@ Dashboard—View recent run history, and current sequencing run status.

@ Samples—Add new samples, import samples, prepare library batches, import library batches and manage attributes.

@ Runs—Plan a run starting from a nucleic acid sample or a library. View, edit, and manage runs. View, edit, and manage runs.

@ Results —View sample results, run results, and verification results.

@ Assays—Manage, create, and import assays. Manage assay preset parameters and panels.

@ Notifications —Receive alerts and messages for password expiration, system critical service failures, system backup failures,
available software updates, and full disk space.

@ Settings —Access audit records and run logs, configure network settings, manage backup settings, restore runs, manage
gene lists, link to Connect user accounts and lon Reporter™ Software accounts, check for software updates, and manage data
archiving, disk space, and users. Field Service Engineers access verification templates during sequencer installation.

Profile—Access the Help system, manage and edit user profile settings, configure an SSH key (system administrator only),
and sign out.
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Genexus™ Integrated Sequencer components

Genexus

Major features and components of the exterior and sequencing reagents bay of the Genexus™ Integrated Sequencer

@ Door to deck chamber. The door is locked in the closed @ Genexus™ Bottle 3 (Cleaning Solution)
position during an instrument run. @ Waste carboy

(2 Power button Waste pipette tip bin
(3) Genexus™ Bottle 1 (Chemical Waste) (© Genexus™ Cartridge

(@) Genexus™ Conical Bottles (Reusable conical bottles for Touchscreen
Genexus™ Cartridge reagent dilution)

@ Sequencing reagents bay door. Doors are locked in the
(®) Genexus™ Bottle 2 (Sequencing Solution)

closed position during an instrument run.
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Genexus™ Integrated Sequencer deck stations =

WARNING! This product contains very strong permanent magnets. People wearing a pacemaker
or metallic prostheses should not use this product. A pacemaker or prostheses may be affected or
damaged if it comes in close contact with a strong magnetic field.

Genexus™ Integrated Sequencer deck stations

NI g
EEEEEEEE

Interior Genexus™ Integrated Sequencer deck components and stations

() PCR amplification station (9) Zone 3 station (Genexus™ Strip 3-GX5™)
@ Microcentrifuge Zone 4 station (Genexus™ Strip 4)

@ Genexus™ Barcodes plate station @ Enrichment plate station

@ Genexus™ Primer Pool Tube station @ Liquid waste disposal port

@ Genexus™ Coupler station @ Waste pipette tip disposal port

@ Chip install station @ Sample plate station

@ Zone 1 station (Genexus™ Strip 1) @ Genexus™ Pipette Tips station

Zone 2 station (Genexus™ Strip 2-AS) @ Robotic pipettor
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Precautions

Precautions

Avoid nucleic acid contamination

IMPORTANT! A primary source of contamination is spurious nucleic acid fragments from previous
sample processing steps. Do not introduce amplified DNA into the work area where the instrument is
located.

Avoid chip damage

IMPORTANT! To avoid possible damage to the chip due to electrostatic discharge, ground yourself
before picking up a chip or placing a chip on a surface such as a lab bench. For example, touch the
metal trim on the chip compartment before inserting or removing a chip from the chip clamp.

Avoid strong electromagnetic radiation

WARNING! Do not use the instrument in close proximity to sources of strong electromagnetic
radiation (for example, unshielded intentional RF sources), as these sources can interfere with proper
operation.

Protection by equipment

A WARNING! The protection that is provided by the equipment can be impaired if the instrument is
operated outside the environment and use specifications, the user provides inadequate maintenance,
or the equipment is used in a manner that is not specified by the manufacturer (Thermo Fisher
Scientific).

A WARNING! This product contains very strong permanent magnets. People wearing a pacemaker
or metallic prostheses should not use this product. A pacemaker or prostheses may be affected or
damaged if it comes in close contact with a strong magnetic field.
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B Guidelines for sample quality, viral RNA copy number, and variantcalling ................... 23

m Copy number determination by gPCR

Guidelines for sample quality, viral RNA copy number, and

variant calling

Use the following recommendations and guidelines for assessing the reliability of variant calls in a
sample with a given viral RNA copy number and quality.

* The amount of viral RNA among samples should be approximately equivalent so that the target
amplification conditions you select are optimal for all samples.

* Ensure that RNA samples were quantified using TagPath™ COVID-19 Combo Kit (Cat. No. A47814).

Viral RNA copy
number

Recommendations and guidelines

100 to 1,000,000
copies

Recommended range for optimal results.

>1,000,000 copies

A sample with more than 1,000,000 copies of viral RNA should be diluted to 1 to
10 for optimal sequencing results.

<100 copies

A sample input that is less than 100 copies of viral RNA may be used, provided
that the samples are of high quality, are not degraded, and do not contain
inhibitors. We recommend that you ignore heterozygous variants called for sample
inputs that are less than 100 copies.

* To reliably sequence low quality samples, the samples must have a viral RNA copy number =100
copies. For partially degraded samples, which likely includes low titer samples, the effective copy
number that can be amplified by the lon AmpliSegq™ SARS-CoV-2 Insight Research Panel - GX is
lower than the viral RNA copy number detected by gPCR because the gPCR products are shorter
than the 250 bp fragments generated by the panel.

¢ Even for samples with viral titer >100 copies, you may observe reverse transcription-derived
false positives if you decrease the minimum allele frequency cutoff below 0.2 (20%). Reverse
transcription-related errors occur randomly across the genome. To minimize calling false-positives,
be certain to amplify a sufficient number of RNA molecules and set the minimum allele frequency to

at least 20%.
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Chapter 3 Sample preparation guidelines
Copy number determination by gPCR

Copy number determination by gPCR

24

Note:

. If your gPCR data give a different relationship between C; and copy number, this is likely a result of
differences in the baseline or threshold selected. Determine the copy number of a sample according
to the known copy number in control samples.

. We recommend that you base copy number on the N Protein C; value.

. If the N Protein C; value is not accurate, use the S Protein or ORF1ab C; values to determine copy
number.

. The copy number is only an estimate.

. The tier is used to select the correct system-installed assay (see step 3 of “Plan a library run” on
page 39).

Approximate copy number to C; conversion—TagPath™ COVID-19 RT-PCR Kkits

TagPath™ C;
Tier Viral copy number
N Protein S Protein ORF1ab
High >1,000 copies <25 <24 <24
Low <1,000 copies >25 >24 >24
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n Create and manage assays

B System-installed assays for use with the lon AmpliSeq™ SARS-CoV-2 Insight

Research Panel — GX . ... e e e e e e e 25
B Copying an assay (manager/administrator) . ........ ... e 26
Genexus [Ion Torrent Dashboard Samples Runs Results Assays 0% @ S

Assays Ma:

Manags Assays ﬂ
Cres

Filter Assays By.., ~

say  [§ Import Assay

Research

ited On
Assay Full Name T Assay Name by 8 Application T Panel % +

v

comine Myeloid v2 - GX5- DNA-w4.2.2 6.6 Myeloid DNAvZ_6.6 DNA Oncomine Myeloid v2 - GX5 - DNA - w4.2.2 Pane 1-11-08 20:15

Manager- and administrator-level users can create and manage assays in Genexus™ Software. This
chapter describes how to copy and edit assays, including system-installed assays. If you are using
a system-installed lon AmpliSeq™ SARS-CoV-2 Insight Research Assay without change, proceed to
Chapter 5, “Samples and library batches”.

IMPORTANT! If you have updated the SARS_CoV_2_lineagelD plugin, you must create a new assay
(see “Copying an assay (manager/administrator)” on page 26).

System-installed assays for use with the lon AmpliSeq™
SARS-CoV-2 Insight Research Panel - GX

The following system-installed assays are available in Genexus™ Software 6.2.1 or later for use with the
lon AmpliSeg™ SARS-CoV-2 Insight Research Panel — GX. Each system-installed assay is configured
with settings that are optimized for viral RNA titer.

Note: Make sure to update your software to the latest available versions of the system-installed
assays. For more information, contact your field service representative. For information on how to
perform software and assay package updates, see “Download software and assay package updates”.

Assay name Sample type
SARS-CoV-2 Insight LowTiter Research Assay Low titer viral RNA
SARS-CoV-2 Insight Research Assay High titer viral RNA
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Copying an assay (manager/administrator)

You can use the system-installed assays in your run plan without change. To modify any assay settings,
you can copy the system-installed assay that best represents your sequencing experiment and sample
type, then edit assay settings as needed.

* [f you are using a system-installed assay without changes, proceed directly to Chapter 5, “Samples
and library batches”.

* To modify a system-installed assay with custom settings, proceed to “Copying an assay (manager/
administrator)” on page 26.

Copying an assay (manager/administrator)

Manager- and administrator-level users can create a new assay by copying an existing system-installed
assay or other custom assay and modifying parameters if needed. Only locked assays can be copied.
To copy or edit an assay, see “(Genexus™ Software version 6.6.0 and later) Copy and edit an assay” on
page 99 or “(Genexus™ Software version 6.2.1 only) Copy and edit an assay” on page 99.

If you are using a new version of the SARS_CoV_2_lineagelD plugin, you must copy the
assay to use the new version of the SARS_CoV_2_lineagelD. See “Create new copy assay for
SARS_CoV_2_lineagelD plugin updates” on page 101.
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B About samples and library batches . ... i e e 27
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B System-installed sample attributes .......... ... .. e 31
B Prepareorimportalibrary batch ... e 32

Genexus | on Torrent Dashboard ~ Samples  Runs  Results Assays & @& 2

Manage Samples

Filter Samples by... ™ Selected Samples: 0 FiCraRyg Al ‘ i

Sample Name Y  Tags Y  CreatedOn 4 anage Attributes in Category T  sampleType Y

Before you plan a run in Genexus™ Software, you must first enter sample information in the software to
assign sample names and provide other information.

From the Samples menu, you can add samples in three ways. You can enter sample information for
individual samples, you can import sample information from a file to create multiple samples, or you can
upload a BAM file to create samples.

About samples and library batches

In Genexus™ Software, the data and attributes that characterize genomic data are called samples. A
sample can be isolated nucleic acid, a specimen that requires nucleic acid isolation, or the sequencing
data that are created from a BAM file that contains sample reads. Before you can plan a run to
sequence or analyze a sample, you must add the information that characterizes each sample in the
software.

A library batch is a group of samples that are sequenced in a Library to Result run. You can create
library batches from samples you have previously added or uploaded to the software. During library
batch preparation, you identify the barcode adapters that were used to prepare the libraries. After you
create a library batch, you can plan and start a run to sequence and analyze the samples in the library.
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Chapter 5 Samples and library batches

Create a new sample

Create a new sample

You can add a new sample in the Samples / Manage Samples screen. The new sample is available to
use in your run.

IMPORTANT! If you are using an NTC control, before proceeding, see “Create NTC sample” on

page 100.

1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, click + Create Sample.

3. In the Create Sample dialog box, complete the required fields.
Attributes identified with a red asterisk (*) in the Create Sample dialog box are required when
adding a new sample. If attribute information is not available when adding a new sample,
substitute mock information to complete the required fields.
For more information, see “System-installed sample attributes” on page 31.

4. Click Save.

The new sample is listed in the Manage Samples screen and is available to use in your run.

Create multiple samples

28

You can create multiple new samples in Genexus™ Software.

If you are using an NTC control, before proceeding, see “Create NTC sample” on page 100.

—

. In the menu bar, click Samples » Manage Samples.

In the Manage Samples screen, click + Create Sample.
In the Create Sample screen, click the Sample Definition (.xls) tab.

In Application Category, select the application category for the samples.
A table with columns specific for the selected application category appears.

(Optional) Click Columns in the upper right corner of the screen to customize the optional
attributes for the samples you would like to create.

¢ Select the checkbox for a sample attribute to add it to the table so that you may enter
information for that attribute.

* Deselect the checkbox for a sample attribute to remove it from the table.

Enter the information for a sample.
Attributes identified with a red asterisk (*) are required.

Click Add Row, then enter the information in the new row for each new sample.

Repeat step 6 for each new sample.
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Import samples

9. Select the checkbox in the row for each sample you would like to create. To select all samples,
select the checkbox in the column heading row.

IMPORTANT! The information for samples that are not selected is not retained by the software.
Ensure that you select the checkbox for every sample you intend to create.

10. Click Save.
The new samples are listed in the Manage Samples screen and are available to use in a run.

Import samples

You can enter sample information for multiple samples directly in Genexus™ Software. When you want
to create more than a few samples, an easy and fast way to add multiple samples in the software is to
create a file of information for a group of samples and import that file.

Sample data files can be used to capture, manage, and edit sample data. You can import sample data
files in TSV, XLS, XLSX, or CSV file formats. For a list of the sample attributes that are included in the
import file, see the Genexus™ Software Help. For ease of use, you can download a Microsoft™ Excel™
template file to create an import file.

You must create custom attributes before importing sample and run information for the attributes to

be propagated through to output files. All attributes that are included in the file that you use to import
samples must be either system-installed attributes or custom attributes that exist in the software. Other
file content is not transferred with the sample.

You can use a file to import sample information into the software. You can create the file, or use a file
that is exported from external LIMS software. Before you import a file from LIMS software, you must
first map the sample attribute names that are named differently in the LIMS file to the attribute used in
Genexus™ Software.

1. In the menu bar, click Samples » Create Sample.
2. In the Create Sample screen, click the Multiple (.xls, .csv, .tsv) tab.

3. In the Application Category dropdown list, select the application category for the samples.

Tip: Use the search field to search for the application category of interest.
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4. Set up a sample file using one of two options.

Option Description
Download a template file, | For more information, see “Download a template file for sample creation”
then edit it to create a on page 31. Upload the edited file using the Browse button.
new file.

Note: When you select Other as the Application Category, you must
enter text in the Application Category text box, then click anywhere in the
screen in order for the template file to be available.

Upload the sample data
from an existing file.

a. Click Browse.
b. Navigate to the file, then click Open.

The data contained in the file populates the table in the screen.

5. In the sample file, edit the sample table and data, if needed.

Option Description
Remove an attribute column. Click Columns, then deselect the column name.
Add an attribute column to the Click Columns, then select the column name. The column names
table. that are listed are Application Category-specific.
Edit sample data. Click the sample row of interest, then edit the text field or

dropdown list for the sample.

Add more samples to the table. Click Add Row, then enter the sample data.

Remove a sample from the table. | Select the checkbox for the row, then click Remove Row.

6. Select the checkbox in the row for each sample to create. To select all samples, select the
checkbox in the column heading row.

IMPORTANT! The information for samples that are not selected is not retained by the software.
Ensure that you select the checkbox for every sample you intend to create.

7. Click Save.
You can place the pointer over (%) (alert) to view more information if needed.

The new samples are listed in the Manage Samples screen and are available to assign to a run plan.
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Download a template file for sample creation

Download a template file for sample creation

You can download a template file, add sample information to it, then use the file to import the sample
data for multiple samples.

Template files contain two tabs. The Instruction tab in the spreadsheet lists and indicates required and
optional attributes, which are the column headings in the Sample Details tab. Use the Sample Details
tab to enter sample information.

Template files contain both the system-installed and the custom sample attributes as column headings.

1. In the menu bar, click Samples » Create Sample.
2. In the Create Sample screen, click the Multiple (.xls, .csv, .tsv) tab.

3. In Application Category, select the application category for the samples.
Template files are specific for each application category.

4. Click Download Template to download the Microsoft™ Excel™ template file.

The template file contains default sample attributes as columns. If custom sample attributes have
been configured in the software, the custom attributes are added to the template file.

5. Save the file to the computer, then open the file, enter sample data in the Sample Details tab.
6. When you are finished adding sample information to the file, save the file.

You can now import the file to Genexus™ Software.

System-installed sample attributes

The following table lists and describes system-installed sample attributes. System-installed sample
attributes cannot be edited. Custom sample attributes and cancer-related attributes are not listed in this
table.

Sample attribute Description

Sample Namel'l | A unique identifier representing the sample.

The sample name can contain only alphanumeric characters (0-9, Aa-Zz), full stops/periods
(-), underscores (_), or hyphens (-), cannot contain spaces, and is limited to a maximum of
20 characters.

IMPORTANT! To prevent erroneous sample selection during run planning, make sure that you
assign a unique and distinguishable sample name for each sample.

Note:
. Samples that have been used in a run cannot be deleted.

. To prevent duplication, the software checks all sample names and returns an error message if
a non-unique sample name is detected.
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(continued)
Sample attribute Description
Collection Date | The date that the sample was collected.
Click [ Calendar to select the date in the correct format.
Gender The biological sex of the sample: Female, Male, or Unknown.
Sample Type A term that describes the sample, for example, FFPE, DNA, DNA & RNA. You can also select
Other, then enter a custom sample type such as Swab (Nasal).
Disease The disease type of the sample. For SARS-CoV-2 samples, select Other, then enter
Category SARS-CoV-2.
Notes An open-entry field for any additional sample information.
' Required attribute

Prepare or import a library batch

A library batch is a group of prepared libraries that are sequenced in the same library run. If you are
planning a run starting from libraries that you have already prepared manually, you must first create a
library batch in Genexus™ Software from samples. You can enter samples in the software or import a
sample file. For more information see:

* “Create a new sample” on page 28

* “Import samples” on page 29

When you plan the library run, you select the library batch. If you are planning a run starting from
nucleic acid samples, skip this step and proceed to “Plan a sample run using the lon AmpliSegq™
SARS-CoV-2 Insight Research Panel - GX” on page 36.

Note:

. Each library in a library batch must have a unique library name.

. Fields identified with a red asterisk (*) are required.

Prepare a library batch

A library batch is a group of prepared libraries that are sequenced in the same library run. If you are
planning a run starting from libraries that you have already prepared manually, you must first create
a library batch in Genexus™ Software from samples that you have added. If you are planning a run
starting from nucleic acid samples, skip this step and proceed to “Plan a sample run using the lon
AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX” on page 36.

1. In the menu bar, click Samples » Manage Samples.

2. In the Manage Samples screen, in the Filter Samples by... dropdown menu, apply the To Be
Prepared filter to limit the displayed samples to those samples that have not been placed in a
library batch.

32
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Prepare or import a library batch

3. Select samples in the list by clicking the checkbox to the left of each sample, then click
-+ Prepare Library Batch.

Genexus | lon Torrent Dashboard Samples Runs  Results Assays A 8
Samples Manage Samples
Filter Samples by... ~ TP Manage Tags  + Create Sample | Columns ~

Selected Samples: T

& Clear £ Edit @ Copy [ Delete [ Export
a Sample Name h Tags h Cated on ~ h g Application Category h Sample Type
Lib: 2021-06-09 15:04 Solid Tumor DNA .
Li 2021-06-09 15:04 Solid Tumor DNA
LibS 2021-06-09 15:04 Solid Tumor DNA
LibSample117 2021-06-09 15:04 Solid Tumor DNA
LibSample116 2021-06-09 15:04 Solid Tumor DNA

4. Inthe Create Library batch screen, in Select Assay, select the assay that you want to run.

The assay determines specific parameters of the run, including any required controls and post-run
data analysis settings. Only locked assays appear in the Select Assay dropdown menu.

Create Library batch

Select Assay: ~

L1

5. In the expanded screen, in Library Batch ID, enter a unique identifier for the library batch.

Note: Library Prep Type: automatically fills for the nucleic acid type specified by the assay you
selected: DNA, RNA, DNA+RNA, or TNA.

Library Batch IDs can contain only alphanumeric characters (0-9, Aa-Zz), full stop/period (.),
underscore (_), and hyphen (-). Required fields are indicated with a red asterisk (*).

6. Select the barcodes from the kit boxes into the appropriate fields.

7. Select the Include NTC checkbox to add no template control sample processing and reporting to
the library batch.
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Prepare or import a library batch

8. Type a unique library name for each DNA and/or RNA library in the appropriate field.

* Library names can contain only alphanumeric characters (0-9, Aa-Zz), full stop/period (.),
underscore (_), and hyphen (-).

¢ If your assay requires specific controls, they are automatically listed in the dialog box. These
controls each require a unique barcode ID within the library batch, but do not require library
names.

9. Select the barcode ID of the adapter used to prepare Dashboard  Samples  Runs  Results  Assays A &)
each library. If appropriate, swap the default barcodes
in the dialog box between DNA, RNA, and Fusions by

clicking the Swap Barcodes swap image.

For example, click the DNA and Fusions swap button. de

Each library in a library batch must have a different

barcode ID. When preparing the physical libraries, best practice is to swap barcodes between
DNA and RNA libraries in consecutive sequencing runs to prevent carryover contamination. The
barcodes that are listed in the DNA Barcode or RNA Barcode dropdown list belong to the
barcode set that was selected when the assay was created.

IMPORTANT! Ensure that the actual barcodes that you used to create the libraries match the
barcodes that you enter in the Create Library batch screen.

10. Enter the Input Quantity for each library.

11. Click Submit to save and submit your selections.

The Manage Libraries screen opens, listing the library batch that you created. Libraries that are
prepared in the same batch have the same Library Batch ID.

Import a library batch

You can import library batch information in the form of an XLS or XLSX file. The import file must include
all required library and kit information.

—

. In the menu bar, click Samples » Manage Library Batches.
2. In the Manage Library Batches screen, click Import Library Batch.

3. In the Import Library Batch dialog box, click Click here to select an assay for which the libraries
are prepared, and to download an example file for import.

If the assay includes more than one library preparation type, a library preparation type dropdown
list appears.

4. Select the library preparation type, such as for the library batch.

5. Select an assay from the list, then click Download.

The assay name is auto-populated in the Microsoft™ Excel™ template file that downloads to your
drive.
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Prepare or import a library batch

6. In the template file, enter or confirm the library batch information.

Template item Description
Reagents tab
Assay Name Auto-populated when assay is selected in step 5 (required).

Extraction Method Type | Auto-populated when assay and library prep type, if applicable, is selected
in step 5 (required).

Library Batch ID Must be alphanumeric (0-9, Aa-Zz), period (.), underscore (_), and hyphen (-)
(required).

Library Kit Barcode For example, Genexus™ Strip 1 and Genexus™ Strip 2-AS barcode (optional).

Panel Kit Barcode For example, lon AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX

barcode (optional).

Libraries tab

Sample Name Must be alphanumeric (0-9, Aa-Zz), period (.), underscore (_), and hyphen (-)
(required).
To Include a no-template control, add a row with NTC for the Sample Name.
Barcode Barcodes used for each sample and control library preparation (required).
Nucleic Acid Type DNA, RNA, or TNA (required).
Input Quantity Library input quantity (optional).
Control Kit Barcode The barcode for the Positive Control and NTC kits used for Sample to Result

and Nucleic Acid to Result runs (optional).

Extraction Kit Barcode | The barcode for the kit used for nucleic acid extraction of a sample
(optional).

IMPORTANT! For DNA and Fusions assays, the DNA library and RNA libraries must be listed

in sequential order per pool for each sample. For example, for a 1-pool DNA and Fusions assay,
order should be DNA, RNA for sample 1, DNA, RNA for sample 2. For a 2-pool DNA and Fusions
assay, library order should be DNA, RNA (pool 1), DNA, RNA (pool 2) for sample1, then DNA, RNA
(pool 1), DNA, RNA (pool 2) for sample 2.

7. Save the file.

8. In the Import Library Batch dialog box, click Select Library batch file, navigate to the saved file,
then select it.

9. Click Upload.

A progress bar followed by an import report displays. If the import process fails, click View errors
to review the reason for failure. The use of an invalid character is an example of an error. For more
troubleshooting support, see “Library batch import fails” on page 83.
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® Plan a sample run using the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX

m Plan alibrary run

Genexus | lon Torrent Samples Runs Monitor Resulis Assays

Runs [ Manage Runs

Manage Runs

Plan Sample Run «
Plan Library Run

Run Name = Enter Run Name =+ Plan Sample Run < Plan Library Run

Run Name Asszay Short Name Total Samples Run Status Actions

Runs created in Genexus™ Software contain all of the settings that are used in library preparation,
templating, sequencing, and analysis, including sample information and plate location, assays, and
barcodes. Runs are used to track samples, consumables, and chips throughout the library preparation,
templating, sequencing, and data analysis workflow.

You can plan runs for sequencing runs that use either nucleic acid samples (sample run) or libraries
that you have previously prepared manually (library run) as input. Genexus™ Software guides you
step-by-step to set up a run that tells you what consumables are needed, and provides a printed run
setup guide to help you load the Genexus™ Integrated Sequencer with the required consumables.

Ensure that you are using the latest version of the SARS_CoV_2_lineagelD plugin (see “Download
plugins” on page 16).

Plan a sample run using the lon AmpliSeq™ SARS-CoV-2
Insight Research Panel - GX

These instructions include specific settings and selections required for a run planned with the lon
AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX. For detailed instructions for planning sample
runs, see the Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910) or the Genexus™
Software 6.2 User Guide (Pub. No. MAN0018955). If you are planning a library run using manually
prepared libraries, or using libraries recovered from a Genexus™ Integrated Sequencer sample run,
proceed to “Plan a library run” on page 39.

Genexus™ Software guides you through the five steps of planning a sample run: Setup, Assays,
Samples, Sample Plate, and Review. You can view progress through the steps in the upper left corner
of the Runs / Plan Sample Run screen.

36 lon AmpliSeg™ SARS-CoV-2 Insight Research Assay — GX User Guide



Chapter 6 Planarun [0

(]
Plan a sample run using the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX

Genexus | lon Torrent

Runs [ Mucleic Acid to Result

Ensure that you have downloaded and installed the appropriate plugins and assay development files.
For details, see “Download assay definition files” on page 17.

1. In Genexus™ Software, click Runs » Plan Sample Run.

2. In the Setup step, enter or make selections.
a. In the Run Name field, enter a unique name.

Genexus | lon Torrent Samples  Runs  Monitor  Results  Assays % 2

Runs / Plan Sample Run

o Setup Name your run plan and configure reporting options.
Plan Reporting (Optional)
Run Name: * Generate Report (2
Test_Plan_1l Default Report +
[ Select Instrument and Plan with Remaining Deck Capacity [ Upload BAM files to lon Reporter Software @

b. (Optional) In the Reporting (Optional) section, select Generate Report to generate a Lab
Report using a report template that you specify in the dropdown list.

Note:

. To create a report template, click Assays » Manage Presets, then in the Report
Templates tab, click + Add New.

. The option Upload BAM files to lon Reporter™ Software is not needed for analysis of lon
AmpliSegq™ SARS-CoV-2 Insight Research Panel — GX sequencing results.

c. Click Next.

Note: If a chip is installed in the sequencer, the Chip View graphic in the lower left corner
indicates the lanes that are available for sequencing.
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3. In the Assays step, select the system-installed assay based on the tier of the stock samples
(determined in Chapter 3, “Sample preparation guidelines”), then click Next.

Tier System-installed assay
Low (<1,000 copies) SARS-CoV-2 Insight LowTiter Research Assay
High (=1,000 copies) SARS-CoV-2 Insight Research Assay

4. Inthe Samples step, select the samples from the list that you want to run with the lon AmpliSeq™
SARS-CoV-2 Insight Research Panel — GX, then click Assign.

IMPORTANT! We recommend that viral RNA copy numbers differ between samples in a run no
more than 1,000-fold (=10 C;) to ensure that read counts for lower titer samples are adequate.

We recommend that you run up to 8 samples per lane (1,500,000 reads per sample). Depending on
sample quality and the titer range of samples, up to 16 samples per lane can be run (750,000 reads
per sample).

The Chip View updates to show the lanes to be used in the run as green. Lane usage is calculated
based on the number of samples, assay type, primer pools used, and minimum reads per sample.
We recommend 1.5 M reads per sample for the lon AmpliSeq™ SARS-CoV-2 Insight Research
Panel - GX.

If the minimum reads per sample x the number of samples exceeds the chip or lane well capacity,
a dialog box appears after you click Next asking you to confirm that you want to continue. After
clicking Yes, the Chip View updates and shows the lane color as red instead of green. In the
example shown at right, seven samples were included in a library batch instead of six. The run is
allowed, but you may not achieve the required reads per sample to pass QC metrics.

5. In the Sample Plate step, review sample positions in the sample plate. Modify the concentration of
samples, if needed, then click Next.

IMPORTANT! If the viral RNA copy number is >1,000,000 copies, we recommend that you dilute
the sample 1 to 10 using one of the following methods.

. Dilute the sample manually. We recommend that you dilute the RNA with THE RNA Storage
Solution (Cat. No. AM7000).

. To have the sequencer dilute the sample for you, adjust the sample concentration in the Conc.
(ng/uL) column of the run plan to 10 times higher than the default value.

6. In the Review step, review the run plan summary, then click Save & Print to print the run setup
guide, if desired. Click Save to save the run without printing.
When saved, the run appears in the run list on the Runs / Manage Runs screen with the name you
specified.

The run is started on the sequencer screen after selecting a run and loading the sequencer.
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Plan a library run

Before planning a library run, you must enter sample information and prepare a library batch in
Genexus™ Software. The library batch selects the assay to be used in the run, and the assay in turn
specifies the barcode set that was used to prepare the sample libraries. If your sample libraries were
prepared using a barcode set not specified in an assay that you want to use in the run, you must:

1. Create a new assay, or copy an existing assay, and specify the new barcode set in assay setup.
2. Prepare a library batch that selects the new assay.
For more information, see “Copying an assay (manager/administrator)” on page 26, and “Prepare a
library batch” on page 32.

Genexus™ Software guides you through the four steps of planning a library run: Setup, Assays, Library
Batches, and Review. Progression through the steps is tracked in the upper left corner of the Runs /
Plan Library Run screen.

Genexus | lon Torrent

1. In the menu bar, click Runs » Plan Library Run.

Note: You can also click 4 Library to Result in the Runs / Manage Runs screen.
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2. In the Setup step, enter a name for the run, then configure the reporting options.
a. In the Run Name field, enter a unique name.

Genexus | lon Torrent Dashboard Samples Runs  Results  Assays A Y @ S

Runs / Library to Result

o Setup Name your run plan and configure options for reports
Plan

Run Name * Select Instrument and Plan with Remaining Deck Capacity

Test_Plan_2 |

Reporting (Optional)

Generate Report (@ O Upload BAM files to Server @ D

teemo.itw (lon Reporter Local)  + IR514 %

Mo Chip on Instrument

S - |

b. (Optional) In the Reporting (Optional) section, select Generate Report to generate a Lab
Report using a report template that you specify in the dropdown list.

Note:

. To create a report template, click Assays » Manage Presets, then in the Report
Templates tab, click 4+ Add New.

. The option Upload BAM files to lon Reporter™ Software is not needed for analysis of lon
AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX sequencing results.

c. Click Next.

If a chip is installed in the sequencer, the Chip View graphic in the lower left corner indicates
the lanes that are available for sequencing.

3. In the Assays step, select the system-installed assay or custom assay based on the viral copy
number in samples (see Chapter 3, “Sample preparation guidelines”), then click Next.

Tier System-installed assay
Low (<1,000 copies) SARS-CoV-2 Insight LowTiter Research Assay
High (=1,000 copies) SARS-CoV-2 Insight Research Assay

Note: For the assay to be selectable at this step, you must have prepared a library batch that
assigns the assay to the batch. For more information about preparing a library batch, see “Prepare
a library batch” on page 32. The assay specifies the barcode set that was used to prepare the
sample libraries.

IMPORTANT! Ensure that you select the assay that corresponds with the sample type to be used
in the run. If you select a wrong assay when you plan a run, the instrument uses incorrect settings
during the run, resulting in invalid sequencing results.
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4. In the Library Batches step, select the library batch or batches that you want to use in the run.

Note: Only one library batch can be selected per assay. However, you can plan a multi-assay
library run if you select multiple, different assays in the Assays step.

The Chip View updates to show the lanes to be used in the run as green. Lane usage is calculated
based on the number of samples, assay type, primer pools used, and minimum reads per sample.
We recommend 1.5M reads per sample for the lon AmpliSeq™ SARS-CoV-2 Insight Research
Panel - GX.

If the minimum reads per sample x the number of samples exceeds the chip or lane well capacity,
a dialog box appears after you click Next asking you to confirm that you want to continue. After
clicking Yes, the Chip View updates and shows the lane color as red instead of green. In the
example shown at right, seven samples were included in a library batch instead of six. The run is
allowed, but you may not achieve the required reads per sample to pass QC metrics.

5. After you select a library batch (or batches), click Next.

6. In the Review step, review the run plan summary, then click Save and Print to print the run setup
guide, if desired. Click Save to save the run without printing.
After saving, the run appears in the run list on the Runs / Manage Runs screen with the name you
specified.

The run is started on the sequencer screen after selecting a run and loading the sequencer.
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Load the sample plate—sample run

Ensure that the SARS-CoV-2 samples that have been quantified by real-time gPCR (see Chapter 3,
“Sample preparation guidelines”).

1. Load sample plate wells with 25 pL of each sample as specified in the run setup guide.
2. Seal the plate with a sheet of Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626).

3. Keep the plate on ice until you are ready to load it in the sequencer.

Guidelines for library quantification—Library to Result runs

* We recommend that you use libraries that are freshly quantified and diluted before pooling in a
library batch.

* Pre-prepared libraries can be quantified by one of the following three methods:
— Quantification using the Agilent™ 2100 Bioanalyzer™ instrument
- Quantification using the Qubit™ Fluorometer
— Quantification by gPCR using the lon Library TagMan™ Quantitation Kit
See one of the following guides for specific procedures.
— lon AmpliSeq™ Library Kit 2.0 User Guide (Pub. No. MANO006735)
— lon AmpliSeq™ Library Kit Plus User Guide (Pub. No. MAN0OO17003)
— lon AmpliSeq™ HD Library Kit User Guide (Pub. No. MANOO17392)

Dilute and pool libraries, and load the sample plate—library
run

1. Dilute each manually prepared and quantified sample library to 200 pM with nuclease-free water.

Note: Each library must be barcoded with a unique barcode or barcode pair. Use this
concentration as a starting point, then titrate up or down based on sequencing results, if needed.
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Dilute and pool libraries, and load the sample plate—library run

2. Add equal volumes of each library to a new 1.5-mL low DNA retention tube so that the total volume
is greater than the volume specified in the run setup guide provided by the software.

3. Mix well by pipetting up and down five times, then transfer the specified volume of each library
batch to the sample plate position specified in the run setup guide.

4. Seal the plate with a sheet of Adhesive PCR Plate Foils (Thermo Fisher Scientific Cat. No. AB0626).

Note: The use of other plate seals may affect performance.

5. Keep the plate on ice until you are ready to load it in the sequencer.
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m Load the sequencer and start a run

B Before YoU Degin .. ..ot e e 44
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After you have planned a run in Genexus™ Software, use the run setup guide provided by the software
to load samples in the sample plate, and to determine which consumables to load in the sequencer.
Follow the step-by-step instructions in the sequencer touchscreen during run setup. The vision system
of the sequencer tracks the addition of consumables in real-time and alerts you if a component is
loaded in an incorrect position, or if an incorrect quantity is loaded.

Before you begin

44

1. Remove the library and templating strips from their boxes in the refrigerator or freezer, and ready
them for loading in the sequencer.
* Genexus™ Strip 1 and Genexus™ Strip 3-GX5™: equilibrate to room temperature for
30 minutes.
* Genexus™ Strip 2-AS and Genexus™ Strip 4: thaw at room temperature for 30 minutes. If you
are delayed in loading, keep the thawed strips on ice or at 4°C until you load them in the
sequencer.

IMPORTANT! Confirm that the strip contents are completely thawed before installing in the
sequencer.

2. Remove primer pool tubes in tube carriers that are needed for the run from the freezer, then thaw
for at least 30 minutes on ice or at 4°C. After thawing, gently tap the primer pool tube or tubes on a
bench surface to ensure that contents are collected at the bottom of the tubes. Keep the tubes and
carriers on ice or at 4°C until you load them in the sequencer.

3. If you are installing a new Genexus™ Cartridge, thaw the cartridge at room temperature for
30 minutes before installing in the sequencer.

4. Genexus™ Strip 1 and Genexus™ Strip 3-GX5™ contain magnetic beads in one or two positions,
yellow or brown in color, that sometimes get trapped in the upper "keyhole" of the tube. Dislodge
these beads from the keyhole before installing the strip in the sequencer. Use the following
procedure for each strip.

a. Invert the strip 3-4 times to dislodge beads that are trapped in the keyholes.
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Before you begin

b. To remove any remaining beads and liquid from the
keyholes, grasp the strip at one end with the strip
seal facing up, then swing the strip with a rapid,
downward centrifugal arm motion, ending with a
sharp wrist-flick.

o

c. Grasp the strip at the other end, then repeat the ..
centrifugal motion.

d. Check tube positions for significant amounts of
beads that are still trapped in keyholes (see the
following figure), then repeat the centrifugal motion,
if needed. It is acceptable if a few beads remain in
the keyhole or on the tube wall, but most should be
either in suspension or in a pellet at the bottom of
the tube.

T LTI LTI T T T C
U \UJ \‘w; \ws “«\,x“ W W \\JJ \ws \ws | “ | !
iSle: S

Example Genexus™ Strip 3-GX5™ before (upper) and after (lower) inversion. The carrier has been removed to
show tube contents more easily.

@ Magnetic beads trapped in keyholes @ Magnetic beads dislodged from keyholes
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Note:

. It is not necessary to resuspend the magnetic beads completely —it is only necessary to
dislodge most of the beads that may be trapped in the keyhole. The instrument resuspends
the beads during the run when needed.

. Fine bubbles can form above the liquid in some tubes after inversion. These bubbles do not

affect the run.

5. Inspect all strips for large bubbles lodged under the surface of the liquid or at the bottom of each
tube or well. Gently tap the strips on a benchtop to dislodge any bubbles without splashing the
contents onto the upper tube walls. If tapping fails to dislodge a bubble, use the technique that is
described in substep 4b until large bubbles are dislodged.

Load the sequencer and start a run

1. Tap Run on the sequencer home screen to start the loading procedure.

Genexus Integrated Sequencer
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Load the sequencer and startarun 0

2. In the Run Selection screen, select the run that you want to use from the list.

Run Salection

Run List

ssplani8

ssplan16

Cancel

Note: If you select a run that requires more lanes than are available on a currently installed chip,

a dialog appears giving you the option to install a new chip, or cancel. If you proceed with a new

chip, a post-chip clean is performed, then the sequencer prompts you to perform the Clear Deck,
UV Clean, Load Deck, Clear Sequencing Reagents, and Load Sequencing Reagents steps.

3. In the Review Run screen, confirm the run and assay selections, then tap Next.

Review Bun

The deck door opens automatically.
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Note:

. If the instrument vision system detects consumables loaded on the deck, the sequencer
prompts you to remove the consumables, then starts a UV Clean.

. Select the Do Force Clean checkbox if there will be an unused lane or lanes on the installed
chip after the run, but you want to start your next run on a new chip after the current run. A force
clean automatically cleans the instrument after the run, eliminating the need for an operator to
execute the cleaning procedure between the completion of the current run and the next run.
Selecting Do Force Clean renders all lanes of the installed chip unusable after the run.

4. Inthe Load Deck screen, the sequencer instructs you step by step to load each required
consumable in a highlighted position on the deck. The sequencer detects the loading of each
consumable in real time and advances to the next component automatically.

Load Deck

IMPORTANT!

. Ensure that you remove the primer pool tube cap or caps before installing the tube carrier on the
deck.

. Ensure that you load the correct type of barcode plate and library strip 2 for the type of run
you are setting up. The sequencer displays a warning if you have installed consumables that are
incompatible with the run you have selected, for example, a Genexus™ Barcodes AS plate or
Genexus™ Strip 2-AS in an HD run.

Note:

. A primer pool tube carrier can only be installed with
the position 1 tube in the back row of the Primer [
Pool Tube Station. Follow the guidance in the run U @ ‘
setup guide for loading the primer pool tube carrier or
carriers in the correct position and order in the station.

. If the sequencer cannot read the correct loading of
an unexpired consumable, tap Help in the lower left
corner of the screen to override the block. After using
this override, the name of the consumable will not @ Position 1
appear in the run summary consumables list. ® Position 2
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Load the sequencer and start a run

If prompted, insert a new GX5™ Chip and Genexus™ Coupler. Insert the chip into the chip install
slot with the chip notch oriented down and toward the front of the instrument.

(1) Notched corner of chip

Note: A chip shuttle under the deck moves the installed chip to loading and sequencing positions
during the run.

IMPORTANT! Insert the Genexus™ Coupler so that it is level to ensure it will properly align with
the GX5™ Chip. A coupler that is installed at an angle or is not level will not align properly to the
chip and can result in a failed run.

When the deck consumables have been loaded, lock the library and templating strips in place by
sliding the latches toward the rear of the deck.

Load Deck

Cancel

If a chip is detected and the strip latches are closed, the Close Deck Door screen appears.
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7. Close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

* |f you installed a new chip in the sequencer, the sequencer prompts you to open the
sequencing reagents bay doors to empty the waste and remove used sequencing reagents
bay consumables. Proceed to step 8.

¢ If you are using a chip that was previously installed and has sufficient lane capacity for the run,
the sequencer prompts you to start the run.

IMPORTANT! The cartridge and bottles in the sequencing reagents bay must be replaced every
time that a new chip is installed, regardless of how many lanes were used in the previous chip.

8. Follow on-screen instructions to empty the waste in the Waste carboy, remove waste pipette
tips, remove the used Genexus™ Bottle 1, Genexus™ Bottle 2, Genexus™ Bottle 3, and Genexus™
Cartridge, then tap Next.

Clear Sequencing Reagents

Empty and replace the waste container
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Load the sequencer and start a run

IMPORTANT!
. Ensure that you empty and replace the Waste carboy and the waste pipette tip bin.

. After replacing the emptied Waste carboy, ensure that you reinsert the waste tube into the
carboy.

. Follow all applicable local, state/provincial, and/or national regulations when recycling or
disposing of consumables and liquid waste.

9. Install a new Genexus™ Bottle 1, Genexus™ Bottle 2 (two required), Genexus™ Bottle 3, and
Genexus™ Cartridge.

Load Sequencing Reagents

Note: The installed reagents can be used for up to 14 days on the sequencer with full
performance. After 14 days, you may observe reduced performance.

After reagents have been installed, the Close Sequencing Reagent Bay Door screen appears.

10. Close the sequencing reagents bay doors.

Close Sequencing Reagent Bay Door
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After the doors are closed, the sequencer automatically starts the run.

At the beginning of the run, the instrument verifies the chip, checks for leaks, then calculates run
time.

Run Workflow Checking for leaks

Calculating time

Calculating time =

g
g
V.

%
Yot

A sequencing run encompasses the following stages:

e Starting * Pre-sequencing
* |Initializing * Sequencing

® Library Prep * Cleaning

¢ Templating

At each stage, the instrument shows the time remaining on the touchscreen.

Note: The time remaining shown on the screen does not include run analysis time.
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Clear the instrument deck and perform a UV Clean  ©5"

Sequencing

CLEL
o0 iy,
&Y %,

00:31:24
B Library Prep

%apun®®

When the run finishes, the sequencer displays the Run Complete screen.

Note: If all the lanes of a chip are used, the chip shuttles to the install position. You are asked to
remove the chip and coupler, and clear the sequencing reagents.

Clear the instrument deck and perform a UV Clean

After a run completes, remove used consumables from the deck and perform a UV Clean to ready the
instrument for the next run.

1. In the Run Complete screen, tap Next to start removal of used consumables.

Sequencing

Run
Complete

The deck door opens.
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2. In the Clear Deck screen, the sequencer provides step-by-step instructions by highlighting the
components to be removed. Unlock the library and templating strips by sliding the latches toward
the front of the deck, then remove the used strips. Remove the remaining deck components
specified by the sequencer.

Clear Deck

P 1 in position 1

3. Inspect the Genexus™ Filter in the liquid waste disposal port and verify that no standing liquid is
present. If standing liquid is present, manually remove the liquid with a pipette, then pull out the
filter. Test the filter with water to determine if a clog is present.

¢ [f the Genexus™ Filter is clogged, replace it with a new filter. For more information, see the
Genexus™ Integrated Sequencer User Guide (Pub. No. MAN0017910).

¢ [f the Genexus™ Filter does not appear to be clogged, a line clog downstream of the filter is
implicated. Contact Technical Support and report a possible deck liquid waste line clog.

4. When finished, close the deck door, then tap Next.

Close Deck Door

Close the deck door, then press Next

A two-minute UV Clean starts.
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Clear the instrument deck and perform a UV Clean

Sequencing

’bﬁﬁ“ "#ﬁ&

00:01:58

UV Clean

Yay uﬂ":‘ﬁ

5. After UV cleaning, if all the chip lanes were used, the sequencing reagents bay doors unlock. Open

the doors, remove used components from the bay and empty the Waste carboy, then tap Next.

Clear Sequencing Reagents

IMPORTANT! Do not discard or remove the conical bottles, unless alerted by the sequencer to
replace the bottles after a conical bottle flow rate test. For more information, see the Genexus™
Integrated Sequencer User Guide (Pub. No. MANO017910).

IMPORTANT! Follow all applicable local, state/provincial, and/or national regulations when
recycling or disposing of Genexus™ Integrated Sequencer consumables and liquid waste.

CAUTION! The Genexus™ Bottle 1 (small waste bottle) contains small amounts of formamide.
Dispose of this waste appropriately.
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Clear the instrument deck and perform a UV Clean

MISE EN GARDE ! Le Genexus™ Bottle 1 (petit flacon de récupération de déchets) contient de
petites quantités de formamide. Eliminez ces déchets de facon appropriée.

6. After removal of used components, close the sequencing reagents bay doors, then tap Next.
The sequencer returns to the home screen.
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Genexus | lon Torrent Dashboard Samples Runs Results  Assays [ L]

Results [ Sample Results

Sample Results

Run Results @
MNon Archived = Selected Samples: 0 (' Refresh Columns =
Verification Results
Sample Name T Assay Name T Run Name T Sample Status T QC Status T

Use the Results menu to review results and data analysis, and to perform data management tasks. You
can view results sorted by sample or by run.

Selection Description
Click Results » Sample Results Select this option to review completed sample results and reports.
Click Results » Run Results Select this option to review completed run results and reports by
assay.

Click Results » Verification Results | Select this option to review data from completed verification runs
that were performed during sequencer installation or performance
qualification.
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Review sample results

In the Results / Sample Results screen, samples that have been sequenced are listed by sample

name.

You can search the list of results by sample name. Enter a search term, then click Q_(Search).

Genexus | lon Torrent Dashboard  Samples Runs Results Assays & & 2
Results | Sample Resul
NenArchived = | Selacted Samples:0 C Refresh | Columns~

Sample Name T Assay Name T Run Name T Sample Status T QCStatus T Started On h Updatedon + T
1IG_thor_gx6.5.20_0CA JJG_thor_6.5.20_0CAV3wS.0.0_DF_1619934957 Completed v 2020-02-0420:29 2021-05-11 13:41
16_d JJG_thor_6.5.20_0CAV3wS.0.0_DF_1619934987 Completed v 2020-02-0420:29 2021-05-11 13:41
161 JJG_thor_8.5.20_0C/ _DF_1612234987 Completed v 2020-02-0420:29 2021-05-11 13:41
16_ oc 5.0.0_DF_1610934987...  OCAw3 DNA Fus w5.0.0 JJG_thor_6.5.20_0CAv3wS.0.0_DF_1619934987 Completed Vg 2020-02-04 20:29 2021-05-11 13:41

The following information appears in the Sample Results screen.

Column

Description

Sample Name

The unique identifier created when the sample was entered into the software. Click the Sample
Name to open the Sample Details screen for the sample. Use the tabs above the Sample Details
to view the run summary, assay metrics, quality control, detailed variant results, and results for
plugins that are associated with the selected assay, if any.

Sample Name

Manager- and administrator-level users can provide their electronic signature on sample results

followed by for completed runs. A sample name followed by (Signed Off) indicates that a manager- or

(Signed Off) administrator-level user has approved the sample results. The signature information appears in
the Lab Report PDF file or a user-created report, if selected. For more information, see “Sign off
on the run results (manager/administrator)” on page 76.

Assay Short A shortened version of the assay name you imported or created.

Name

Run Name The unique name of the run given when it was created in the software.

Sample Status

The status of the run or sample (for example: Completed, Running, Failed, Terminated, Pending,
Stalled).

QC Status The QC status of a completed run.
Note:
. (Passed) indicates that the sample passed all QC metrics.
. X (Failed) indicates that the sample failed a QC metric.
. = (Not Calculated) indicates that a sample did not undergo QC analysis.
Started On The date and time when the run analysis was started.
Last Updated The date and time when the last action was completed on the run.
On
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(continued)
Column Description
Actions Click the appropriate link. To see more actions, click (More Options).

* Lab Report—Download the Lab Report (available only for samples with a sample status of
completed.

* Audit—View the audit trail for the run.
* Notes—View or add notes to a run.

* CSA—Download customer support archive (CSA) log files for the run to help with
troubleshooting.

Review run results

In the Results / Run Results screen, runs that are pending, running, failed, stalled, aborted, or
completed are listed.

You can search the list of results by run name or PCR plate number. Enter a search term, then click
Q (Search).

The following run information appears in the Results / Run Results screen.

Column Description
Run Name The unique name of the run given when it was created in the software. Click a run name to open
the Run Summary.
Assay Short The shortened unique identifier of an Assay hame. You can view the complete list of Assays and
Name Assay Short Names in the Assays » Manage Assays screen.

Total Samples

The total number of samples in a run.

Run Status The status of the run (for example: Not Started, Pending, Analysis Running, Executing Plugin,
Completed, Terminated, Archival: In Progress, Purification Complete).

PCR Plate A unique identifier for the 96-well plate used for library preparation and templating. For more

Number information, see “Assign PCR Plate” on page 60.

Started On The date and time when the run was started.

Updated On The date and time when the last action was completed on the run.

Actions!'- 2] Click the appropriate link. To see more actions, click (More Options).

* Delete—Delete the run.
* Audit—View the audit trail for the run.

* CSA—Download customer support archive (CSA) log files for the run to help with
troubleshooting.

* Upload to IR—Upload sample information to lon Reporter™ Software for further analysis.

¢ Assign PCR Plate—Enter a unique identifier for the 96-well plate used for library preparation
and templating. For more information, see “Assign PCR Plate” on page 60.
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(continued)
Column Description
Actions!3] * View Plan—View detailed run plan information.

* Review—Review samples that do not have a concentration within a specified threshold after
purification, but before library preparation.

For more information, see the software help system.

* Abort—Allows you to abort a run after purification, but before sequencing. This action
is available when the run status is Purification Review Required, or when the run
status is Purification Completed and some purification samples have been excluded from
sequencing.

' The actions that are available depend on the type of run.
[ Upload to IR is not available for BAM run results or for archived runs in which BAM files have been removed.
Bl More actions that are available for Sample to Result runs only.

Assign PCR Plate

Genexus™ Software lets you track and associate a run with the PCR plate used in the run. The

PCR plate is the 96-well plate that is used for library preparation and templating. You can assign a
unique identifier, a PCR Plate Number, to runs that have a status of Library Preparation Completed,
Sequencing Completed, or Run Completed. The PCR plate number that you enter is shown in the
Run Results screen and if needed, can help you track libraries and troubleshoot. Later, if you sequence
the remaining libraries in a different sequencing run and assign the PCR plate number to the run, you
can easily search for and find all run results associated with the libraries in the PCR plate.

Note: You should assign a PCR plate to a run if there are leftover libraries that you want to use at a
later time to perform a Library to Result run. You can look up the PCR plate number on completed runs
to get the library and barcode mapping, then enter the same Barcode information into the Library to
Result run.

1. In the menu bar, click Results » Run Results.

2. In the Run Results screen, place the pointer over the row of a run of interest, then click Assign
PCR Plate number.

3. In the Assign PCR Plate Number dialog box, confirm, edit, or enter the PCR Plate Number.

The PCR plate number must be between 1 and 10 characters. Only alphanumeric characters
(numbers 0 to 9 and letters A to Z), period (.), underscore (_), or hyphen (-) are allowed. Spaces are
not allowed.

4. Click Submit to associate the PCR plate with the run.
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Lab Report

Lab Report

The Lab Report is a PDF report of the results for each sample in a sequencing run. The assay used in
the run determines the data that is included in the report.

To automatically generate a Lab Report for each sample during data analysis of a run, select the
Generate Report checkbox in the Setup step when you plan the run (for more information, see
Chapter 6, “Plan a run”). To generate a Lab Report for each sample after a run is complete, see

“Generate a variant report” on page 89.

When a Lab Report has been generated for a sample, it is available for download in two places:

* Alink is available in the Results / Sample Results screen in the Actions column for that sample.
Click the link to download the PDF.

* |n the Summary tab of the Results screen for a sample, click -+ (More Options) » Generate
Report.

Lab reports can be electronically signed by manager- and administrator-level users. Electronically
signed reports have (Signed Off) after the sample name in the Sample Results screen. The electronic
signature is included in the footer of the report. For more information, see “Sign off on the run results

(manager/administrator)” on page 76.

A Lab Report for an lon AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX assay contains the
following sections and information.

Section

Description

Sample Details

The sample information that is entered into the software. You can customize the format
of the Sample Details section when you create a new report template. To create a new
report template, click Assays » Manage Presets, then in the Report Templates tab, click
-+ Add New.

Test Description

A description of the report or assay that was entered in the report template.

Comments

Laboratory comments entered in the report template.

Sequencing Run
Details

Contains the following subsections:
* Assay—the assay name and panel used
* Analysis—the run date and name of the user who sent the run to the instrument

* Run Details—the consumables used in the run

Reagents

Details about run consumabiles, including part numbers, expiration dates, and lot numbers.

Control QC
Evaluation Metrics

* Run QC Evaluation Metrics —a summary of the run quality control metrics
¢ Sample QC Evaluation Metrics—a summary of the RNA sample quality control metrics
* Templating Control QC—a summary of the CF-1 quality control metrics
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Download a variant report

62

You can download a variant report for a sample result of interest from the Results / Sample Results
screen, from the pane that shows the report, or as part of a download of results files.

In the menu bar, click Results » Sample Results.

2. Download the report with one of the following options.

Option Procedure

Download a ZIP file that contains all variant | In the Sample Results screen, click the sample name
reports for a sample result. of interest in the Sample Name column, then click
+++ (More Options) » Download Files.

Download the variant report in PDF format | Click the Reports tab then, in the pane of the report of
from the Reports tab for the sample interest, click (More) » Download Report.
results.

Download the variant report as part of the
results files for a specific sample in the
Results screen.

A ZIP file that contains the PDF report is downloaded to the computer if you download reports
from the Sample Results screen or as part of the results files. A report in PDF format downloads if
you use the Reports tab for the download.

In the Sample Results screen, place the pointer over the row of the sample of interest, then click
Report.

i~ Selected Samples: 0

Sample Name T Assay Name n Run Name T Sample Status b ¢ QC Status

& b . LibSamplel_2021-07-09-22-04-4

A ZIP file that contains the PDF report downloads automatically.

4. Extract the downloaded files, then open the PDF file in an appropriate viewer.
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View sequencing results and assay metrics

For every run, you can view assay-specific results and sample-specific results. Assay-specific
results include assay metrics, such as final read data, and assay-level plugin information, such

the CustomerSupportArchive and generateConsensus plugin results. Sample-specific results include
summary statistics, QC results, and sample-specific plugin results. The following run and sample-
specific result information is available in each set of assay and sample result tabs.

Tab

Description

Assay-specific results

Assay Metrics

Run metrics that apply to all of the samples in an assay, including lane loading, lon Sphere™
Particle (ISP) statistics, and read statistics for each barcode. For more information, see
“View assay results—Assay Metrics tab” on page 65.

Plugins

Results that apply to all of the samples in an assay, including the generateConsensus
and CustomerSupportArchive (CSA) plugins. For more information, see “View
generateConsensus plugin results” on page 70.

Sample-specific results

Summary An overview of the results for the sample, including Sample Details, and Key Metrics. For
more information, see “View sample results—Summary tab” on page 73.

QC The quality metrics for the sample sequenced in the run. For more information, see “View
sample results—QC tab” on page 74.

Plugins Results generated from sample-specific SARS-CoV-2 plugins used to analyze the

sequenced sample. For more information, see “View sample results —Plugins tab” on
page 76.

1. To view sequencing results for a particular sample, including variant calls, click Results » Sample

Results.

2. In the Sample Name column, click a sample name.

3. In the Results screen, click the Summary, QC, Plugins, and tabs to view the different types of
sample-specific results and data.
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4. Toggle between different assay-specific and sample-specific results for the run with the dropdown
menus.

Genexus | lon Torrent (1) (2] (3 Jll 501_R159331_TWO1_200cp_LowTit_Rp01 ¥

Results / SARs_test_0.0.2_run2¥ / SARS-CoV-2testiTv0.02¥ / SO1_R159331_TWO1_200cp_LowTit_RpOl Select Sample
o
501_R159331_TWO01_200cp_LowTit_RpO1

R

S01_R159331_TWO01_200cp_LowTit_Rp01  Summa -

Sample Details

@ Run Result: The run name is listed.
@ Select Assay: Click the assay name of interest to view the assay metrics for the run. Click Select Assay to
return to the Run Summary tab for the selected run.

@ Select Sample: Click a sample name to view the sequencing results for the sample. Click a different sample
name to view other sample results for the run and selected assay. Click Select Sample to return to the Assay
Metrics tab for the selected assay.

Option Description
Run Results The run name is listed. Multiple runs are listed only if the run has been
dropdown menu reanalyzed. For more information, see “Reanalyze a run” on page 87.
Select Assay Toggle between different assays used in the run. If only one assay is associated
dropdown menu with the run, only one assay name is listed.

To remove the assay selection, select Select Assay from the dropdown menu.
Removing the assay selection opens the Run Summary tab for the run selected
in the Run Results dropdown menu.

Select Sample Toggle between different sample results for the selected run and assay.

dropdown menu Click Select Sample from the dropdown menu to open the Assay Metrics tab
for the assay shown in the Select Assay dropdown menu.

All of the samples that were run with the same assay share the same assay metrics. All other
results are sample-specific.
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5. To view more options, click --- (More Options) at the far right of the Results screen.

Option Description

Reanalyze Reanalyze a run with a new assay.
For more information, see “Reanalyze a run” on page 87.

Run Plugin Run plugins on your sequencing data after a sequencing run is complete.
Run Report The run report includes assay metrics and the record of reagents that were used in
arun.

For more information, see “Download a run report” on page 69.

Download Files | Download sequencing results, plugin results, audit and logs, and lab report files.
For more information, see “Results files” on page 78.

Generate Report | Generate a Lab Report for each sample in a sequencing run. Plugin results are not
reported in the Lab Report.

For more information, see “Lab Report” on page 61.

Sign Off Manager- and administrator-level users can provide their electronic signature on
sample results for completed runs.

For more information, see “Sign off on the run results (manager/administrator)” on
page 76.

CSA Customer support archive (CSA) log files for the run to help with troubleshooting.

View assay results—Assay Metrics tab

Assay metrics include various chip metrics for the run, such as well and lon Sphere™ Particles (ISPs)
statistics. For runs with multiple assays, metrics are provided for each assay in the run. Summary
metrics are displayed at the top of the screen, followed by sample-specific metrics in the Run Samples
table. Barcode-specific metrics are listed in the Barcodes With Reads Reported table. All barcodes
with reads detected, even if unassigned or not planned in the run, are listed to allow you to readily
identify the source of any barcode cross-contamination.

To view the assay metrics for a run, in the Results / Run Results screen, in the Run Name column,
click the run name of interest. In the Run Summary screen, select an assay from the Select Assay
dropdown menu. To view the metrics for another assay in the run, select a different assay from the
dropdown menu.

Assay metrics are assay-specific and cannot be viewed within the sample results screens. To view
assay metrics, ensure that Select Sample is selected in the Select Sample dropdown menu.
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Genexus | lon Torrent Samples Runs Monitor Results

s | SARs_test_0.0.2 run3_2000cp 2 ¥ | SARS-CoV-2test v0.0.2¥ | Select Sample ¥
SARS-CoV-2test v0.0.2

Loading Total Bases Final Reads Mean Raw Accuracy 1x

84.53% 6.07G 31,146,986 99.23

Loading 84.53% (3

Enrichment 99.22% @

56,447,283
Library 99.8% 3@

Final Reads 55.29% (2

31,146,986

To view the assay metrics for a run, in the Results / Run Results screen, in the Run Name column,
click the run name of interest. In the Run Summary screen, select an assay from the Select Assay
dropdown menu. To view the metrics for another assay in the run, select a different assay from the
dropdown menu.

Assay Metrics

Metric Description
Loading The number and percentage of total addressable wells on the chip that contain an ISP.
Enrichment The number and percentage of wells ISPs that contain live ISPs.
Library The number and percentage of wells with live ISPs that contain Library ISPs.
Final Reads Library reads passing all filters that are recorded in the output BAM files. This value can be

different from the total number of reads due to technicalities associated with read trimming
beyond a minimal requirement.

Total Bases The number of filtered and trimmed base pairs that are reported in the output BAM file.

Raw Read Accuracy | The raw read accuracy across each individual base position in a read calculated as, (1-
[total errors in the sequenced reads]/[total bases sequenced]) x 100. Raw read accuracy

is measured at each base across the length of the read and is based on 1x sequencing
coverage; raw read accuracy is not based on consensus accuracy across multiple reads for
the same base position.

Wells with ISPs The number of wells that contain an ISP.

Total Addressable Wells on the chip that can be physically reached by a library.
Wells

Empty Wells The percentage of total addressable wells on the chip that do not contain an ISP.

Wells with Live ISPs | Loaded wells with ISPs with a signal of sufficient strength and composition to be associated
with the library or control fragment key.
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Assay Metrics (continued)

Metric

Description

Wells with Library
ISPs

Loaded wells with live ISPs with a key signal that is identical to the library key signal.

Control ISPs Loaded wells with live ISPs with a key signal that is identical to the control fragment key
signal.
Polyclonal Wells with a live ISP that carries clones from two or more templates.
To view polyclonal metrics, mouse over the first low quality portion (gray) of the Final Reads
bar plot.
Final Reads 55.29% (@) Filtered 44.71%
31,146,986 N
Final Reads(31,146,986) / Wells with Library 15Ps{56,333,577 W Polyclonal: 18665409 (33.13%)
Low Quality Loaded wells with a low or unrecognizable signal.
To view polyclonal metrics, mouse over the second low quality portion (gray) of the Final
Reads bar plot.
Final Reads 55.29% (3 Filtered 44.71%
31,146,986 N
Final Reads(31,145,986) / Wells with Library 15Ps(56,333,577 \1 Low Quality: 2303629 (4.09%) ‘
Filtered Out The total percentage of filtered reads, or the sum of the percentages of polyclonal, low
quality, and adapter dimer reads.
Adapter Dimer Loaded wells with a library template of an insert size less than 8 bases.

Loading Density

A visual representation of chip loading. Red color indicates areas of higher density of
loading. Blue color indicates areas of lower density of loading. The following example
illustrates a sequencing experiment where two lanes on the chip are uniformly loaded with
ISPs.

Loading Density

e S
Y

Run Samples

The Run Samples table lists read data for each individual sample in the assay.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide 67



e

Q)

Chapter 9 Review data and results

View sequencing results and assay metrics

Column

Description

Sample Name

The unique identifier created when the sample was entered in the software.

Nucleic Acid Type | The sample nucleic acid type, such as DNA, RNA, or TNA.

Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for a
sample.

Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to the

sample. The reads are independent of length reported in the output BAM file.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases The total number of called bases that have =99% accuracy (or less than 1% error rate)
aligned to the reference for the sample.
Uniformity The percentage of bases in all targeted regions (or whole genome) with a depth of coverage

>20% of the mean read coverage.

Read Length
Histogram

A histogram that presents all filtered and trimmed library reads that are reported in the output
BAM file (Y-axis) and the mean read length in base pairs (X-axis). The shape of the histogram
should closely resemble the library size distribution trace without the adapter sequences.

Read Length Histogram

0 50 100 150 20 250

Click the Read Length Histogram to open an expanded view.

Barcodes with Reads Reported

The Barcodes with Reads Reported table lists barcode-specific metrics.

Column Description
Barcode The unique identifiers of the dual barcode pair assigned to the DNA and/or RNA library for a
sample.
Total Reads The total number of filtered and trimmed reads with the listed dual barcodes assigned to the

sample. The reads are independent of length reported in the output BAM file.

Mean Read Length

The average length, in base pairs, of usable library reads for each sample.

=Q20 Bases

The total number of called bases that have =99% accuracy (or less than 1% error rate) aligned
to the reference for the sample.
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Download a run report

You can download a run report summary in PDF format. The run report includes assay metrics and the

record of reagents that were used in a run. For information about the contents of the run report, see the
Genexus™ Software Help. If you entered extraction kit barcodes for samples when you prepared library

batches or when you planned the run, the extraction kit barcodes are listed in the run report.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, in the Sample Name column, click the sample name of interest.

3. Click the Reports tab.
Multiple panes including a Run Report pane, a Variant Report pane, and any panes for
customized reports that have been generated are shown.

4. Inthe Run Report pane, click Download Report to download a run report summary in PDF
format.

View assay results—Plugins tab

The Plugins tab shows results of assay-level plugin results, including CustomerSupportArchive,
generateConsensus, SARS_CoV_2_annotateSnpEff, and SARS_CoV_2_lineagelD results, that are
specified in the SARS-CoV-2 assay to run during the analysis stage of the run. Results for a plugin

that is manually executed after completion of a run also appear here (see “View sequencing results and
assay metrics”, step 5) .

Review SARS_CoV_2_annotateSnpEff plugin results

The SARS_CoV_2_annotateSnpEff plugin generates an annotated list of variants. You can use this
plugin to annotate variants and perform multi-sample comparisons.

Additional details, including definitions about parameters, can be found at https://pcingola.github.io/
SnpEff/se_outputsummary/.

1. Click Results » Run Results in the menu bar, then click a run name of interest.

2. In the Run Summary screen, select an assay from the Select Assay dropdown menu, then click
the Plugins tab.

3. Inthe SARS_CoV_2_annotateSnpEff section, click a barcode name.

4. Click a barcode to see the variant lists with SnpEff annotations.
The SnpEff summary contains statistics about the variants.
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5. To see a SnpEff report for a barcode, click Review in the SnpEff Report column or click the
barcode, then click snpEff_summary.html.

An HTML file of the results opens in a new browser window.

6. To download a ZIP file with summary reports for all variants, scroll to the bottom of the section,
then click SARS_CoV_2_annotateSnpEff.zip.

The ZIP file contains annotated variants in VCF output files for each barcode.

View generateConsensus plugin results

The generateConsensus plugin generates a consensus genome sequence from one or more selected
samples using the variantCaller results and outputs multi-FASTA results for direct batch upload to
GISAID website.

1. Click Results » Run Results in the menu bar, then click a run name of interest.

2. In the Run Summary screen, select an assay from the Select Assay dropdown menu, then click
the Plugins tab.

3. In the generateConsensus section, click Download Sample Consensus Sequences FASTA to
download the FASTA files. A dialog box opens that allows you to perform the following actions.

* Upload a file to rename the FASTA headers.
* Set a maximum percent N (% of no-call bases in the sample sequence) for the files that you
want to download.

Set an upper limit, if desired, click Update, then click Download.

Genexus | lon Torrent Samples Runs Monitor Results Assays

Results / SARS_test_0525_run2 ¥ / SARS-CoV-2Insight ¥ / Select Sample ¥

SARS-COV-2 InSight  Assay Metrics  Plugins
IONUUaI_u14s- S07 R160628 ATCC_VR1986HK_100cp Pv2.6_L2S_RpO1 x’l.'-l‘:f- SUT_RTBUBZE_ATLL_VRITSSOHR_TUUCD_PVZ b_L2S_RPUI1__2U1Y- z B
lonDual_0147 nCoV nCoV
lonDual_0144- 2019- S08 R160628 ATCC VR1986HK 100cp Pv2 6 L2S Rp02 2019-
onbud S08_R160628_ATCC_VR1986HK_100cp_Pv2 6_L2S_Rp02 e Y L e T s Rl
lonDual_0148 nCoV nCoV
o 20 ¥ items per page 1-8of B ftems

+« Download Barcode Summary Report
Download Consensus Sequences FASTA

No consensus sequences were omitted due to high %N. (Optional) Use a file to rename the FASTA headers:
« Download (8) Sample Consensus Sequences FASTA

Choose File | No file chosen

Maximum Percent N: 99 % | Update
8 references are available for download.

Download | Cancel
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Hows

4. Click the generateConsensus.html link to open a table of generateConsensus results for each
sample listed by barcode name. Click Download Barcode Summary Report to download a table
file for the data shown in the screen.

. generateConsensus_5.16.0.6.html

Full Reference: lon_AmpliSeq_SARS-CoV-2.20210205.Reference
variantCaller Repert: Sample specific
Barcode to FastaHeader Mapping: None
Minimum Read Depth: 20

Maximum Percent N: 99

Major Allele Only: No

Minimum Variant Frequency: 0.5

Minimum Variant Frequency for HP InDels:

Barcode Name

lonDual_0143-
lonDual_0147

lonDual_0149-
lonDual_0153

lonDual_0142-
lonDual_0146

lonDual_0157-
lonDual_0161

lonDual_0160-
lonDual_0164

0234 [5

Sample

S07_R159331_TW01_200...

S09_R158331_TW01_200...

S06_R158331_TW01_200

813_R159331_TW01_200.

S516_R159331_TW01_200...

0.6

Reference Contig Sample Contig Name Variants
2018-nCoV S07_R159331_TW01_200cp_LowTit_Rp07__2019-nCoV 4
2018-nCoV S09_R159331_TW01_200cp_LowTit_Rp09__2019-nCoV 3
2018-nCoV S06_R159331_TW01_200cp_LowTit_Rp06__2019-nCoV 4
2019-nCoV $13_R159331_TW01_200cp_LowTit_Rp13_2019-nCoV 4
2018-nCoV $16_R159331_TW01_200cp_LowTit_Rp16_2019-nCoV 4

"] items per page

No consensus sequences were omitted due to high %N
= Download Barcode Summary Report

HOM SNP

HOM
InDel

1

HET SNP

HET InDel  Percent N

0 3.2862
0 3.9564
0 3.2662
0 32862
0 3.2862

1-5of 16 items

5. In the generateConsensus results table, click a barcode in the leftmost Barcode Name column to
view the generateConsensus Report for that library.

« Consensus Sequence Summary Statistics

« TVC Variant Calls Summary
+ Download Consensus Sequence

generateConsensus Report

Sample Name: S07_R159331_TW01_200cp_LowTit_Rp07

lonDual_0143-lonDual_0147_SARs_plus_0.0.2_run2_Auto_R_2021_03_02_15_08_42_jon

Sample Contig Name: 807_R159331_TW01_200cp_LowTit_Rp07__2019-nCoV

Reference 2019-nCoV
Total Variants 4
Homozygous SNPs 3
Homozygous InDels 1
Heterozygous SNPs 0
Heterozygous InDels 0
Percent N 3.2662%

6. Click links for Consensus Sequence Summary Statistics, TVC Variant Calls Summary, and
Download Consensus Sequence to review detailed sequence information for the sample.
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Run the SARS_CoV_2_lineagelD plugin and review results

The SARS_CoV_2_lineagelD plugin assigns a lineage to a barcode using the Pangolin software (see
https://cov-lineages.org/).

Ensure that you are using the latest version of the SARS_CoV_2_lineagelD plugin (see “Download
plugins” on page 16).

If you are using a new version of the SARS_CoV_2_lineagelD plugin, you must copy the
assay to use the new version of the SARS_CoV_2_lineagelD. See “Create new copy assay for
SARS_CoV_2_lineagelD plugin updates” on page 101.

2 Insight LT _@

SARS_CoV_2_lineagelD

Lineage Pangolin GC  Note Most common countries EarBestdate Description

@ Header
(2 More Options icon

The version of Pangolin software is displayed in the header of the SARS_CoV_2_lineagelD section.
The SARS_CoV_2_lineagelD is regularly updated to align with updates to Pangolin software. To analyse
results using another version of Pangolin software contact support.

To see the definition of a parameter, place the pointer over the column title.
1. Click Results » Run Results in the menu bar, then click a run name of interest.
2. Click --- (More Options).
3. Click Run Plugin.

4. Inthe Run Plugin dialog box, select one or more assays in the run, then select the latest version of
the SARS_CoV_2_lineagelD plugin to run on those assays.

5. Click Run.
While plugins are running, the Run Plugin link is unavailable for that run.

6. In the Run Summary screen, select an assay from the Select Assay dropdown menu, click the
Plugins tab, then scroll to the SARS_CoV_2_lineagelD section.

A summary table of the coverage analysis, by barcode, is included in the SARS_CoV_2_lineagelD
summary pane.

7. To view Lineage results for a barcode, click the Lineage for that barcode.
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8. Click Download Barcode Summary Report to download a CSV file with barcode summary
results.

SARS-CoV-2 Insight LT Assay Metrics Plugins

lonDual 0143- o0 ) CovExeb 5ngR_20KT102019_18cPem

lonDual_0147
lonDual_0144-
onbuaL $85_CoVExGb_5ngR_200kT102019_18cPar
lonDual_0148
(1] 20

. | Download Barcode Summary Repcrtl

View sample results —Summary tab

The Results screen displays details about the sample and a summary of the metrics for the sample.
You can view the Results screen for a sample starting from sample or run results, but navigating from
sample results requires fewer steps.

To view sample results in the Results screen, click Results » Sample Results in the menu bar, then
click a sample name to open the Results screen.

The information that is displayed depends on the assay that was used in the run. You can toggle
between different assays used in a run with the Assays dropdown list at the top of the screen.

Section Description

Sample Details

Sample Name A unique identifier representing the sample. Click the Sample Name to open the

Sample Details screen for the sample. Use the tabs above the Sample Details to view the
run summary, assay metrics, quality control, detailed variant results, and results for plugins
that are associated with the selected assay, if any.

Collection Date The date that the sample was collected.
Gender The biological sex of the sample: Female, Male, or Unknown.
Sample Type A term that describes the sample, for example, DNA, DNA & RNA, RNA

Disease Category The disease type of the sample.

Cancer Type The type of cancer that is represented by the sample.!']
Cancer Stage The stage of the cancer from which the sample was collected.!"]
% Cellularity The percentage of tumor cellularity in the sample. This is a whole number between

1 and 100. The % Cellularity attribute is applicable to only FFPE samples.[']
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View sequencing results and assay metrics

(continued)

Section

Description

Key Metrics

Average Base
Coverage Depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity Of Base
Coverage

The percentage of bases in all targeted regions (or whole genome) that are covered by
at least 20% of the average base coverage depth reads. Cumulative coverage is linearly
interpolated between the nearest integer base read depths.

% Base Reads On
Target

The percentage of filtered reads that are mapped to any targeted region relative to all reads
mapped to the reference. A read is considered on target if at least one aligned base overlaps
at least one target region. If no target regions (file) was specified, this value is the percentage
of reads passing uniquely mapped and/or non-duplicate filters, or 100% if no filters were
specified.

1 Not applicable to lon AmpliSeq™ SARS-CoV-2 Insight Research Panel — GX.

View sample results—QC tab

The QC screen displays quality metrics for each sample that was sequenced in a run. This information
is also accessible through the Monitor menu within 72 hours of starting the run on the sequencer.

If a sample fails a single test metric, the sample fails that QC test. A sample must meet all QC
parameter thresholds of a particular QC test in order to pass. The QC status is broken down into the
following categories.

. (Passed) indicates the sample passed all QC metrics.

¢ X (Failed) indicates the sample failed a QC metric.

® — (Not Calculated) indicates a sample did not undergo QC analysis.

Note: If a sample fails to meet one or more QC parameters, you can reanalyze a run (see “Reanalyze a
run” on page 87).

To view the QC screen, in the Results / Sample Results screen, click a sample name in the Sample
Name column. In the Results screen, click the QC tab. The QC status for each metric is indicated
beneath each QC test (Run QC, Templating Control QC-CF-1, and Sample QC-RNA).

The data displayed in the screen depend on the assay that was used in the run.

Metric Description
Run QC General run quality control information.
Key Signal The average signal after software processing for library ISPs that identically match the

library key (TCAG).

Percent Loading

The number of wells with ISPs divided by the number of the total addressable wells in a
run.

Raw Read Accuracy

The average raw accuracy across each individual base position in a read, where raw
read accuracy is calculated as 100 * (1 - (sum(per base error)/sum(per base depth))).
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View sequencing results and assay metrics

Metric

Description

Templating QC—CF-1
Control

Sequencing quality metrics of the control fragment. These metrics indicate
templating success.

Average Reads Per Lane

The number of CF-1 reads divided by the number of chip lanes used in the run.

Base Call Accuracy

The probability that a given base is called correctly.
1 — (total number of errors for all positions in CF-1) / (total number of CF-1 base reads).

Mean AQ20 Read Length
(bp)

Average length, in base pairs, at which the accuracy rate is =99% for CF-1 reads.

Key Signal

The average signal after software processing for CF-1 ISPs that identically match the
CF-1 key.

Sample QC - RNA

Sequencing quality metrics of the sample RNA library.

Uniformity of Base
Coverage

The percentage of bases that are covered by at least 20% of the average base
coverage depth reads.

Read Length Histogram

The histogram presents all filtered and trimmed library reads that are reported in the
output BAM file (Y-axis) and the mean read length in base pairs (X-axis). The shape
of the histogram should closely resemble the library size distribution trace without the
adapter sequences.

Read Length Histogran
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View sample results —Plugins tab

The Plugins screen shows sample-level plugin results, including coverageAnalysis results, that are
specified in the SARS-CoV-2 assay to run automatically during the analysis stage of the run.

To view sample-specific plugin results, click Results » Sample Results in the menu bar, click a sample
name to open the Results screen, then click the Plugins tab.

Sample-specific plugins forSARS-CoV-2 sequence analysis

Plugin Description

SARS_CoV_2_controlStat | Provides QC metrics for the human expression control targets included in the lon

AmpliSeg™ SARS-CoV-2 Insight Research Panel — GX, and metrics for the relative
expression of SARS-CoV-2 and human control targets in a sample. Click the barcode
link to view the report in a new browser tab. Hover on a column heading to see details.

coverageAnalysis Generates a Coverage Analysis Report that includes read statistics and coverage charts

specific to the sample. Click the barcode link to view the report in a new browser
tab. For more information, see “coverageAnalysis plugin in Genexus™ Software” on
page 93.

Sign off on the run results (manager/administrator)

76

Manager- and administrator-level users can provide their electronic signature on sample results for
completed runs. In the Results / Sample Results screen, a sample name followed by (Signed

Off) indicates that a manager- or administrator-level user has approved the sample results. The
signature information appears in the Lab Report PDF file or a user-created report, if selected. For more
information, see “Lab Report” on page 61. For information on how to create a report template, see the
software help system, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

Multilanguage support for PDF report generation is provided. By default, reports are generated in
the language that is selected in the Report Template used. When reports are generated in multiple
languages, Sign Off occurs only in the report of the default language.

A manager- or administrator-level user can update report template selections during sign off.

This feature allows you to meet Title 21 CFR Part 11 of Federal Regulations that establishes the
United States Food and Drug Administration regulations on electronic records and signatures, password
policies, and user activity auditing.

1. In the menu bar, click Results » Sample Results.
2. In the Sample Results screen, click the sample of interest in the Sample Name column.
3. In the upper right-hand corner of the screen, click --- (More Options) » Sign Off.

4. In the Electronic Signature dialog box, enter your user name, password, and comments.
ltems identified with a red asterisk (*) are required fields.

5. In the Meaning of Signature dropdown list, select Approval.

6. Inthe Report Template dropdown list, select the report template that you want to use.
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Download results files for a sample result

In the Report Customizations section, in the Lab Report pane, select the types of variant calls
that you want to include in each report. For assays that use Reporting Gene Lists, you can
customize the variants by reporting category.

In Footer Field, enter any text that you want to appear in the footer of the PDF report pages.

If you entered footer information in the Footer Field when you created a report template, the
same footer information appears in the Electronic Signature dialog box. You can enter new footer
information to override the report template.

Click Sign Off to confirm your electronic signature.

In the menu bar, click Results » Sample Results to return to the Results / Sample Results
screen.

In the row of the sample of interest, click Report to download the report.

Download results files for a sample result

You can download results files for a sample result in Genexus™ Software.

1.

2.

In the menu bar, click Results » Sample Results, or Results » Run Results, then do one of the
following procedures.

Option Selection

Download files for a sample

Download results files for a In the Results / Sample Results screen, place the pointer over the row
sample from the list of sample | of a sample of interest, then click Download Files.
results.

Download resullts files for a 1. In the Results / Sample Results screen, in the Sample Name

selected sample from the column, click the sample name of interest.

Results screen.
2. Click -+ (More Options) » Download Files.

Download files for a run or assay

Download results files for a In the Results / Run Results screen, place the pointer over the row of
run from the list of run results. | a run of interest, then click Download Files.

Download results files for a 1. In the Results / Run Results screen, in the Run Name column,
selected run or assay from the click the run name of interest.

Results screen. . . o
2. Click the run or assay of interest from the results navigation bar.

3. Click -+ (More Options) » Download Files.

In the Download Files dialog box, select the files to download, then click Download.
For information about the files, see “Results files” on page 78.

The selected results files are downloaded in one ZIP folder.
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Results files

The following files can be downloaded from the View Results screen for each sample. The files that are
available for download vary depending on the assay used. Results files include the sequencing data,
results from the analyses, such as variant files, and audit and log files. For a list and descriptions of
plugin output files, see the Genexus™ Software Help.

For instructions to download results files, see “Download results files for a sample result” on page 77.

Option

File name

Description

Variants

SmallVariants Filtered vcf File
(-veh)l

SmallVariants.filtered.vct

Listing of variant results in variant
call format (VCF).

VariantOutput filtered vcf file
(-veh)l]

VariantOutput.filtered.vct

Listing of filtered variant results in
variant call format (VCF).

Sequencing results

Unmapped Bam File (.bam)

<barcode> rawlib.basecaller.bam

Unmapped barcode BAM file;
output after mapping reads to
reference.

Mapped bam file (.bam)

merged.bam

Mapped BAM file of combined
barcode reads.

Mapped Bam Index File (.bai)

merged.bam.bai

Mapped BAM Index file.

Basecaller FASTAQ File (.fastq)

<barcode> rawlib.
basecaller.fastqg

FASTQ file of the barcodes used.

Processed Bam File

merged.bam.ptrim.bam

Mapped BAM file of combined
barcode reads.

Processed Bam Index

merged.bam.ptrim.bam.bai

Mapped BAM index file.

Test Fragment Basecaller
FASTAQ File (.fastq)

rawtf.basecaller.fastqg

FASTQ file for the test fragment.

Audit and Log

Analysis Log File

analysis.log

Analysis log file.

Run Summary

Info.csv

Contains information about the
run and analysis, including
software version details, sample
details, library details, run
details, assay details, reagent
and consumable information, run
and sample QC metrics, and
instrument summary.

Run Audit PlannedRun-AuditTrail.pdf Contains all audit records
pertaining to the run.
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(continued)
Option File name Description
Reports

Lab Report <language> <sample name> A PDF report that contains
_AD Lab Report <assay name> sample-specific results. For more
<date>.pdf information, see “Lab Report” on

page 61.
SARS_CoV_2_ControlStat
SARS_CoV_2_ControlStat (.xIs) | <run name> ion.bc summary.xls Provides QC metrics for the

human expression control targets
included in the lon AmpliSegq™
SARS-CoV-2 Insight Research
Panel — GX, and metrics

for the relative expression of
SARS-CoV-2 and human control
targets in a sample.

Coverage Analysis

Coverage Statistics (.txt) <barcode> <sample name> A summary of the statistics
_ion.stats.cov presented in the tables at the top
of the plugin report. The first line
is the title. Each subsequent line is
either blank or contains a statistic
title followed by a colon (:) and its

value.

Chromosome Base Coverage <barcode> <sample name> Base reads per chromosome

Summary (.xls) _ion.chr.cov summary data used to create
the default view of the Reference
Coverage Chart.

Amplicon Coverage Summary | <barcode> <sample name> Coverage summary data used to

(.xls) _ion.amplicon.cov create the Amplicon Coverage
Chart.

Coverage Analysis Summary <barcode> <sample name> PDF file showing tables for

(.pdf) _ion.summary amplicon read coverage and

target base coverage, charts for
depth of coverage, amplicon
coverage, and reference coverage,
and representation plots

Base Depth Of Coverage (.xIs) |<barcode> <sample name> Coverage summary data used to
_ion.base.cov create the Depth of Coverage
Chart.

' You can view the extracted files individually, or upload a VCF file to a software application that accepts VCF files, such as lon Torrent™
Oncomine™ Reporter software.
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Genexus™ Integrated Sequencer—general and QC

troubleshooting

Observation

Possible cause

Recommended action

A consumable is not
recognized by the sequencer
after loading on the deck

The consumable (for example,
a strip, pipette tip box) is
correctly placed but is not
completely inserted into its
position, causing it to be
misaligned with its expected
position.

Ensure that the consumable is pressed
completely into place. Apply firm pressure on
the item so that it fits snugly into its deck
position.

The barcode of the
consumable is not readable by
the instrument.

Tap Help in the lower left corner of the

Load Instrument screen and follow on-screen
instructions to override the block manually.
Note that the name of the consumable does
not appear in the list of consumables in the
run summary.

If the behavior continues in subsequent runs,
contact Technical Support.

Consumable version does

not match the Genexus™
Software version. For example,
a consumable compatible

with Genexus™ Software 6.6

is installed in a sequencer
updated for Genexus™
Software 6.8.

Ensure that you are using consumables
compatible with the software installed on the
sequencer.

Run Status = Failed

Details: In the Genexus™
Software Run Result screen,
the Run Status for a
completed run is listed as
"Failed". In the Sample
Results screen, the Sample
Status is listed as
"BaseCallingActor FAILED".

Chip calibration failed due to a
chip problem, or an instrument
problem.

Repeat the run with a new chip. If the problem
persists, contact Technical Support.
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Genexus™ Integrated Sequencer—general and QC troubleshooting

Observation

Possible cause

Recommended action

A lane that has been used
is not crossed out in the
sequencer screen

Details: After completion of a
run, the lane used in the run
was not crossed out, so that
the next run could reuse the
lane.

A chip problem caused a
datacollect failure to read
efuse.

In the sequencer screen, tap Settings » Clean

instrument to perform a clean instrument.

For details, see See the Genexus™ Integrated
Sequencer User Guide. After cleaning, start a

new run.

The number of sample reads
is low, CF-1 metrics pass QC,
but read ratio of inline controls
is low.

Details: If CF-1 reads per lane,
accuracy, and mean AQ20
read length are good, and

read ratio of inline controls
(endogenous vs. spike-in) is
low (<< 3), a problem with
sample input is indicated.

For more information, see the
Genexus™ Software Help.

Nucleic acid input may have
been insufficient, and/or the
nucleic acid was degraded.

For a sample run, re-quantify nucleic acid

samples and/or perform sample QC to ensure

that the expected nucleic acid input and size

was loaded.

If needed, re-isolate and purify nucleic acid
samples.

The number of sample reads
is low, but CF-1 metrics pass
QC, and read ratio of inline
controls is normal

Details: If CF-1 metrics
passed QC, and read ratio of
inline controls is normal (~ 3),
a problem in library preparation
unrelated to sample input or
quality may be indicated. For
more information, see the
Genexus™ Software Help.

One or more of the Genexus™
Strip 1 strips used in the run
had magnetic beads trapped in
the tube 5 keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see “Before you begin” on
page 44.

An incorrect assay was
selected for the run, or library
amplification parameters were
not optimal.

Ensure that you have selected the correct
assay and reviewed assay parameters.

Library strips were
inadequately equilibrated to
room temperature (Genexus™
Strip 1), or incompletely
thawed (Genexus™ Strip 2-AS
or Genexus™ Strip 2-HD)
before loading in the
sequencer.

Ensure that Genexus™ Strip 1 strips are
fully equilibrated to room temperature, and
Genexus™ Strip 2-AS strips are completely
thawed before loading in the sequencer.

The number of sample reads is
low, and CF-1 metrics fail QC

Details: If CF-1 metrics failed
QC, a problem in templating
or sequencing is indicated.
For more information, see the
Genexus™ Software Help.

One or more of the Genexus™
Strip 3-GX5™ strips used in
the run may have had an
excessive amount of magnetic
beads trapped in the tube 6 or
7 keyhole.

Repeat the run with strips that you have
verified have no trapped beads. For more
information, see “Before you begin” on
page 44.
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Genexus™ Software

Observation

Possible cause

Recommended action

The number of sample reads is
low, and CF-1 metrics fail QC

Details: If CF-1 metrics failed
QC, a problem in templating
or sequencing is indicated.
For more information, see the
Genexus™ Software Help.

(continued)

Template strips were
inadequately equilibrated to
room temperature (Genexus™
Strip 3-GX5™), or incompletely
thawed (Genexus™ Strip 4)
before loading in the
sequencer.

Ensure that Genexus™ Strip 3-GX5™ strips
are fully equilibrated to room temperature,
and Genexus™ Strip 4 strips are completely
thawed before loading in the sequencer.

The sequencing chip or
coupler was defective or leaky.

Repeat the run with new chip and coupler. If
low performance continues, contact Technical
Support.

The run was started >14 days
after the last initialization was
performed, or on an expired
initialization.

Perform a Clean instrument procedure
(Settings » Clean instrument). For more
information, see See the Genexus™ Integrated
Sequencer User Guide. After the Clean
instrument procedure, install new a chip, and
new sequencing reagent bottles and cartridge
in the sequencing reagents bay, then repeat
the run.

Note: Reagents are stable on the sequencer
for 14 days, after which you may experience
decreased performance. For more information,
see Appendix A: Troubleshooting in the
Genexus™ Integrated Sequencer User Guide
(Pub. No. MANO017910).

Genexus™ Software

Observation

Possible cause

Recommended action

Cannot sign in to Genexus™
Software

You either entered an incorrect
password or you are signed
out due to several failed login
attempts.

Contact the Genexus™ Software system
administrator.

Batch sample import fails

One or more entries in

the sample-import spreadsheet
contains special characters,
lines breaks, unexpected
spaces, incorrect entry length,
incorrect date formatting, or
other formatting errors.

Check each entry for correct formatting,
correct any errors, and repeat the import.

Blank rows were copied into
the sample-import template file
from a different source.

Rows that appear empty can contain hidden
formatting that conflicts with the import
function. Start with a clean sample-import
template file, and be careful to copy only those
rows that contain actual data.

82

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide



Appendix A Troubleshooting
Genexus™ Software

Observation

Possible cause

Recommended action

Batch sample import fails
(continued)

The sample import
spreadsheet contains a
nonunique sample name.

Every sample name in the software must be
unique. Ensure that the spreadsheet does not
contain any duplicate sample names, then
repeat the import. Note that the system check
is not case-sensitive, so a sample name of
ABC1 conflicts with abc1.

The headings in the sample
import spreadsheet do not
match the sample attributes in
the software.

The headings must match the sample
attributes in the software exactly. Check the
headings for spelling or other errors.

Map a sample attribute if needed.

Library batch import fails

One or more entries in

the library batch import
spreadsheet contains special
characters, lines breaks,
unexpected spaces, incorrect
entry length, incorrect date
formatting, or other formatting
errors.

Check each entry for correct formatting,
correct any errors, and repeat the import.

Blank rows were copied
into the library batch import
template file from a different
source.

Rows that appear empty can contain hidden
formatting that conflicts with the import
function. Start with a clean library batch
import template file, and be careful to copy
only those rows that contain actual data.

The library batch import
spreadsheet contains a
nonunique Library Batch ID.

Each Library Batch ID in the software must
be unique. Ensure that the spreadsheet does
not contain any duplicate IDs, then repeat
the import. The system check is not case-
sensitive. For example, a Library Batch ID of
ABC1 conflicts with abc1.

A sample name entered

in the library batch import
spreadsheet does not match
a sample name listed in the
Manage Samples screen.

Ensure that the sample names entered into the
spreadsheet are correct and match an existing
sample name added to the software.

The Barcode ID name format
does not exactly match the
format that is used in the
Prepare Library Batch dialog
box.

Use the name format following the

Barcode ID name format found

in the Barcode Set reference lists

(Settings » References » Barcode Set), for
example: lonDual_0101 through lonDual_0196,
or lonHDdual_0101 to lonHDdual_0132.

An invalid library, control, or
panel kit barcode has been
entered in the spreadsheet.

Ensure that you have correctly entered a valid
kit barcode in the appropriate cell of the
spreadsheet.

The spreadsheet template that
you used is from a previous
software version.

New fields in the template file can be added
with new software versions. Ensure that you
download the template file from the current

software version.
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Genexus™ Software

Observation

Possible cause

Recommended action

The assay | created does not
appear in the menu when | plan
arun

Forgot to lock your assay.

Go to Assay tab » Manage Assays and make
sure that the assay is locked.

Cannot upload my panel or
hotspots

Issues with BED file format or
files do not end in .bed.

Ensure your file is in the correct BED format
and has a .bed extension.

Allele coverage does not match
hotspot coverage

The coverage value reported
under the Variants tab and
Allele Coverage tab can be
different.

No action required. The coverage value
reported under the Variants tab is the
coverage after down-sampling, while the
Allele Coverage tab reports the raw coverage
without down-sampling. Down-sampling can
speed up variant calling for some over-
sampled positions. The down-sampling
threshold for Genexus™ Software variant
calling is 400.

Variants tab is missing hotspot
entries

Details: The remaining entries
are present.

Hotspot BED file contains
entries that are incorrectly
formatted.

Check that BED file entry is correctly
formatted. See the following examples:

SNP entry: chr1 2337276 2337277 SVA_322 0
+ REF=C;0BS=T;ANCHOR=G AMPL

Deletion entry: chr1 201341175 201341180
SVA_497 0 + REF=AGAAG;0OBS=;ANCHOR=C
AMPL

Insertion entry: chr1 236978992 236978992
SVA_621 0 + REF=;0BS=TCTG;ANCHOR=T
AMPL

Ensure that the REF values match the actual
reference coordinate of hg19.

The results of the run do not
appear in the Results / Run
Results screen

The instrument disk space is
full.

Clear disk space on the sequencer. For more
information, see "Manually delete run data" in
Genexus™ Integrated Sequencer User Guide
(Pub. No. MAN0017910).

Cannot download run result
files

The run failed.

Create an assay with the correct configuration
for the samples, then reanalyze the samples.
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Guidelines for lon AmpliSeq™ SARS-CoV-2 Insight
Research Panel - GX settings

In Genexus™ Software, the system-installed assays are configured with settings that are optimized for
each sample type (see the Genexus™ Software Help). If needed, you can copy a system-installed assay,
then modify settings (see “Copying an assay (manager/administrator)” on page 26). The following table
provides guidelines on modifying key assay settings and recommendations for quality control metric
threshold values.

IMPORTANT! Modifications to system-installed assay settings have not been validated. We
recommend that you use system-installed assay settings. Consult your local Field Service Engineer
before modifying default assay settings.

Workflow step Setting Guidelines
Panel Minimum Read | This value determines the number of samples that are allowed on a chip. The
Count Per Genexus™ Software uses this value to calculate how many lanes a run plan
Sample uses, then assigns samples accordingly.

Minimum Read Count Per Sample =
(12,000,000 x number of lanes)+(number of samples)

To increase or decrease the sequencing depth, adjust the Minimum Read
Count Per Sample parameter. If higher sequencing depth is desired, decrease
the number of samples per lane or increase the number of lanes used.

QC Mapped Reads | 1,500,000
(Sample QC -
RNA) Mean Read >150

Length (bp)
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(continued)
Workflow step Setting Guidelines
Parameters Sample input By default, the target sample concentration for the lon AmpliSeq™

Maximum (ng)

SARS-CoV-2 Insight Research Panel — GX is set to a single value in the

assay settings, where a sample input maximum is set to the same value

as sample input minimum. You can modify the parameters to set a sample
concentration range by adjusting the sample input maximum and minimum
values as needed. The target concentration for a sample is the middle point of
the range.

When you modify the sample input maximum and minimum values, the
Sample Concentration Maximum (ng) and Sample Concentration Minimum
(ng) parameters are auto-adjusted to reflect the new maximum concentration
values.

Note: The sample volume that is required for library preparation is not
adjustable. The volume depends on the number of primer pools in the assay,
sample type, and library chemistry. For specific sample volumes to load onto
the sample plate, see “Dilute and pool libraries, and load the sample plate—
library run” on page 42.

When you set a range for sample concentration in the assay settings,

the instrument does not dilute the sample during the run as long as the
concentration of a sample is within the designated range. If the sample
concentration is outside of the range that is designated in the assay settings,
the instrument dilutes the sample to the target concentration (the middle point
of the range). For more information, see “Dilute and pool libraries, and load the
sample plate—library run” on page 42.

Reanalyze a run

If a sequencing run fails to meet one or more QC parameters defined by the assay, you can adjust the
assay parameters and reanalyze a run. For more information, see .

Reanalysis of runs can start from the alignment, basecalling, or signal processing steps. When you
reanalyze a run, the reanalysis is applied to all samples in the assay.

Reanalysis from
the

Description

Signal processing | The option to reanalyze a run from the signal processing step is available only when
step the following conditions are met.

*  When a run fails during the basecalling step or earlier.

* When the run has not already been successfully reanalyzed.

Reanalysis at the signal processing step uses DAT files.
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(continued)

Reanalysis from

the Description

Basecalling step The option to reanalyze a run from the basecalling step is available only when a run or
reanalysis successfully completes the signal processing step.

Reanalysis at the basecalling step uses .wells files.

Alignment step The option to reanalyze a run from the alignment step is available only when a run or
reanalysis successfully completes the basecalling step.

Reanalysis at the alignment step uses BAM files.

Note:

. Manager- and administrator-level users can reanalyze a sequencing run only if the run completed
without any critical alarms or errors. If the run aborted or produced major alarms or errors, the run
cannot be reanalyzed.

The files needed for the stage of reanalysis that you select must be present in the software. For
example, if the .wells files for the run have been removed from the software, you cannot reanalyze from
basecalling. Instead, reanalyze the BAM files at alignment. Administrator-level users can manage the
settings and schedule to backup and delete files and data. For more information, see the software help
system, or the Genexus™ Software 6.8 User Guide (Pub. No. MAN0026409).

You can reanalyze a run with any compatible assay that exists in the software. Alternatively, you can
create a new assay or copy the original assay that was used in a run and modify assay parameters if
needed. For more information, see Chapter 4, “Create and manage assays”.

1. In the menu bar, click Results » Run Results.

2. In the Results / Run Results screen, in the Run Name column, click the run name of interest.

w

In the upper right corner of the screen, click --- (More Options) » Reanalyze.

b

In the Reanalyze dialog box, enter or select the following information.
a. In Reanalysis Run Name field, enter a reanalysis run name.

b. In Start Reanalysis from dropdown list, select Alignment, Basecalling or Signal
Processing.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX User Guide



Appendix B Supplemental information
Generate a variant report

c. Inthe Current Assay in Run column, select the checkbox in the row of each assay that you
want to reanalyze, then in the Choose Assay to Reanalyze column, select an assay that you
want to use for each reanalysis from the dropdown list.

Reanalyze X

Alignment =

Current Assay in Run Choose Assay to Reanalyze Updated Annotations

Oncomine Myeloid v2 - GX5 - DNA - w5.0.0 -
v0.0.2

Oncomine Comprehensive Plus-C clinvar(20220328)

5. Click Reanalyze.

Follow the progress of the reanalysis in the Results / Run Results screen in the Run Status column,
and in the Results / Sample Results screen in the Sample Status column. When reanalysis is
complete, the new results can be viewed by clicking the run name corresponding to the reanalysis
assay in the Results / Run Results screen. Runs that have been reanalyzed are appended with ¢& after
the run name.

Generate a variant report

The Lab Report is generated in the language that is selected in the report template. You can customize
this report by generating it in another language.

You can generate a new variant report for sample results after a run is complete. A & (Lock) in the
variant report indicates that the electronic signature option for the report is locked. After a variant report
is locked, the report cannot be electronically signed by any other user.

You can generate multiple reports for a sample result, if each report is named uniquely, and is
generated in a different language, or uses a different report template.

When generating a customized report, you can update any report template selections. You can use this
procedure to generate multiple reports for a sample, if a unique report name is entered for each report.
For example, you may want to generate reports for different languages, or reports that use different
templates.

1. In the menu bar, click Results » Sample Results.
2. In the Results / Sample Results screen, click the sample of interest in the Sample Name column.

3. Select the Reports tab, then click + Generate Variant Report.
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4.

In the Generate Report dialog box, change the name of the report that is generated by the
software, if needed, then select the report template and language of the report.

a. If the report template includes the option to include custom images from the results, click

Upload Image, then select the images to include in the report, and enter a title for the image,
and if needed enter a description and footnote for the image.

b. If the option to make custom text Editable on Report Generation was selected when the
report template was created, enter a title in the Custom Text section and if needed, a
description.

The Report Template list includes the report templates that are associated with the assay that was
used in the run. For information about creating report templates, see the software help system, or
the Genexus™ Software 6.8 User Guide.

If you select the same report template that was used to generate a variant report, and have not
locked that report, the new selections you make override the previous variant report.

Click Generate.
A draft version of the report is added to the Reports tab.

A pane for the new report is added next to the Run Report pane in the Reports tab. Reports that have
been generated are available for download in the Reports tab, in the Sample Results screen, and in
the ZIP package that contains results files.

Configure Connect Platform accounts in Genexus™
Software (manager/administrator)

Manager- and administrator-level users can configure a link in Genexus™ Software to one or more
Thermo Fisher™ Connect Platform accounts. This account type is called a Connect Platform account in
Genexus™ Software.

When a Connect Platform account is configured and active, administrator-level users can perform tasks
in the Genexus™ Software.

Download the latest software updates
Download more plugin software

Download assay definition files

Download software configuration packages

Before you configure a Thermo Fisher™ Connect Platform account you must have a valid Connect
Platform account on the thermofisher.com website. If you do not have a Connect Platform account,
create a new account at thermofisher.com/connect. Click Sign up now, then enter the information
that is required to create a new account. Click Create account at the bottom of the screen to complete
the registration.
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In Genexus™ Software, click &3 (Settings) » Thermo Fisher Account.
In the Thermo Fisher Account Settings screen, click + Create Account.

In the Create Thermo Fisher Account dialog box, enter the information that is needed to create
the account.

Item Description

Account Type | Select Genexus.

Name Enter a name to identify the account in the Thermo Fisher Account Settings screen in
Genexus™ Software.

The name can contain only alphanumeric characters (0-9, Aa-Zz), periods (.),
underscores (_), or hyphens (-). For example, enter Lab_Admin.

User Name | The username is the email that you used to register for the Connect Platform account.

Password Enter the password for the Connect Platform account.

Download software and assay package updates

In order to download and install software and assay package updates, you must first:

Configure a Thermo Fisher™ Connect Platform account. For instructions, see the Genexus™
Software Help.

Ensure that the Genexus™ Integrated Sequencer is running on the latest Genexus™ Software
version.

Connect your Genexus™ Integrated Sequencer to the internet.

In the menu bar, click 3 (Settings) » Software Updates, then click Software Updates in the
upper right corner of the screen.

The Software Updates screen opens with App Store enabled.

Genexus | lon Torrent Dashboard Samples Runs Results Assays O @& 29

Category Instrument Type Installed Version Installed On

From the Filter Software by... dropdown list, select Software to view available software package
updates or Assay Templates to view available assay package updates.
The list of available updates is displayed.

In the Actions column, in the row of the package of interest, click Download.
After completion of the download, the Download link changes to an Install link.

Click Install. When the confirmation window appears, click Yes to confirm that you want to install.
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When installation of the package is complete, click Installed Software in the upper right corner of the
screen, then verify the installation of your package.
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coverageAnalysis plugin in Genexus™ Software

Use the coverageAnalysis plugin to view statistics and graphs that describe the level of sequence
coverage produced for targeted genomic regions. The results for a run analyzed with the plugin vary
based on the library type that you select when you configure the plugin. You can export some charts as
graphics, such as the Amplicon Coverage Chart and the Reference Coverage Chart.

Reads statistics

The library type determines which statistics are presented. The following tables describe the statistics
that are generated by the coverageAnalysis plugin. The statistics that are displayed in your report
depend on the type of library that is used in your sequencing experiment. Definitions are in tooltips.
Almost every statistic, plot, link, and functional widget in the report provides tooltips with definitions.
Place the pointer over a heading or description in the report to view the tooltip.

General statistics

Statistic Description

Number of The total number of reads mapped to the reference genome.
mapped reads

Percent reads The percentage of filtered reads mapped to any targeted region relative to all reads mapped

on target to the reference. If no target regions file is specified, this value will be the percentage of reads
passing uniquely mapped and/or nonduplicate filters, or 100% if no filters were specified. A read
is considered on target if at least one aligned base overlaps at least one target region. A read
that overlaps a targeted region but where only flanking sequence is aligned, for example, due to
poor matching of 5' bases of the read, is not counted.

Amplicon read coverage statistics

The following statistics describe the reads that are assigned to specific amplicons. Each sequence
read is assigned to exactly one of the amplicons specified by the targets file. If a read spans multiple
amplicon targets, the target region that the reads covers most is assigned. In the event of a tie, the
target that is the closest to the 3' end is assigned.

Statistic Description

Number of amplicons | The number of amplicons that is specified in the target regions file.

Percent assigned The percentage of reads that were assigned to individual amplicons relative to all reads
amplicon reads mapped to the reference. A read is assigned to a particular (inner) amplicon region if any
aligned bases overlap that region. If a read might be associated with multiple amplicons, it
is assigned to the amplicon region that has the greatest overlap of aligned sequence.

Average reads per The average number of reads assigned to amplicons.

amplicon
Uniformity of The percentage of amplicons that had at least 20% of the average number of reads per
amplicon coverage amplicon. Cumulative coverage is linearly interpolated between nearest integer read depth

counts.
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(continued)

Statistic

Description

Amplicons with at
least N reads

The percentage of all amplicons that had at least N reads.

Amplicons with no
strand bias

The percentage of all amplicons that did not show a bias towards forward or reverse
strand read alignments. An individual amplicon has read bias if it has =10 reads and the
percentage of forward or reverse reads to total reads is greater than 70%. Amplicons with
<10 reads are considered to have no strand bias.

Amplicons reading
end-to-end

The percentage of all amplicons that were considered to have a sufficient proportion of
assigned reads (70%) that covered the whole amplicon target from 'end-to-end'. To allow
for error, the effective ends of the amplicon region for read alignment are within 2 bases of
the actual ends of the region.

Amplicon base
composition bias

A number that represents the proportion of amplicons showing low representation (<0.2x
mean reads) in the lower and/or upper quartiles of amplicons ordered by increasing G/C
base pair content of their insert sequences. The value is relative to that in the center 50th
percentile of amplicons and weighted by the standard deviation of representation over all
amplicons. An RMS (root mean square) value is used so that a bias greater in either upper
or lower quartiles produces a larger value than a mean bias seen more equally in both outer
quartiles. The value is 0 if the uniformity of amplicon coverage metric is 100%, however,
the value is not necessarily high at lower amplicon uniformity.

Target base coverage statistics

The following statistics describe the targeted base reads of the reference. A base covered by multiple
target regions is counted only once per sequencing read.

Statistic

Description

Bases in target
regions

The total number of bases in all specified target regions of the reference.

Percent base reads
on target

The percent of all bases covered by reads aligned to the reference that covered bases in
target regions. Clipped bases, deletions, and insertions (relative to the reference) are not
included in this percentage.

If no specific target regions were specified, the whole genome is the targeted regions.

Average base
coverage depth

The average number of reads of all targeted reference bases. This is the total number of
base reads on target divided by the number of targeted bases, and therefore includes any
bases that had no coverage.

Uniformity of base
coverage

The percentage of bases in all targeted regions (or whole genome) that is covered by
at least 20% of the average base coverage depth reads. Cumulative coverage is linearly
interpolated between nearest integer base read depths.

Target base coverage
at Nx

The percentage of target bases covered by at least N reads.
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Statistic

Description

Target bases with no

strand bias

The percentage of all target bases that did not show a bias toward forward or reverse
strand read alignments. An individual target base is considered to have read bias if it has
>10 reads and the percentage of forward or reverse reads to total reads is greater than
70%. Target bases with <10 reads are considered to have no strand bias.

Percent end-to-end

reads

The percentage of on-target reads that fully cover their assigned amplicon (insert) from
‘end-to-end'. To allow for error, the effective ends of the amplicon region for read alignment
are within 2 bases of the actual ends of the region.

Example Coverage Analysis Report

The following is an example of a Coverage Analysis Report generated by the coverageAnalysis

plugin for an lon AmpliSeg™ DNA and fusions run. For a DNA and fusions run, the DNA and fusion
coverage results are viewable by clicking the respective links in the Barcode Name column of the
coverageAnalysis results table.

Library tvpe: AmpliSeq DNA and Fusions
Reference: hgl? (DNA)
Target regions: QCAv3.20180426.designed UnmergedDetail

Log B e Reads)
']

= it B A i T UL R

Percent reads on target

Number of mapped reads

3,248,826

Average base coverage depth

Beference Locaton

Amplicon Read Coverage Target Base Coverage

~ ' Uniformity of base coverage

Number of amplicons 3,781 Bases in target regions 349,355
Percent assigned amplicon reads  94.23% Percent base reads on target 92 05%
Average reads per amplicon 809.7 Average base coverage depth 869.9
Uniformity of amplicon coverage — 96.54% Uniformity of base coverage 96.05%
Amplicons with at least 1 read 99.95% Target base coverage at 1x 99.88%
Amplicons with at least 20 reads  99.34% Target base coverage at 20x 99.31%
Amplicons with at least 100 reads  97.86% Target base coverage at 100x 97.85%
Amplicons with at least 500 reads  74.50% Target base coverage at 500x T2.74%
Amplicons with no strand bias 95.29% Target bases with no strand bias  94.84%
Amplicons reading end-to-end 95.69% Percent end-to-end reads 91.08%
Amplicon base composition bias 0.714
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Library type: AmpliSeq DNA and Fusions
Reference: OCAv3_designs 022619 Reference (RNA)
Target regions: OCAv3 designs 022619 Reference

Rt of Amphcans

L]

020

=10

Number of mapped reads

Percent reads on target

FUST T ST DT T ST g P

Binnad numbers of reads

Amplicon Read Coverage

Mumber of amplicons 896
Amplicons with at least 1 read 189
Amplicons with at least 10 reads 94
Amplicons with at least 100 reads 48
Amplicons with at least 1000 reads 23
Amplicons with at least 10K reads 14
Amplicons with at least 100K reads 1
Amplicons with no strand bias 882
Amplicons reading end-to-end 49

Amplicon base composition bias 0.036

601,669
100.00%

Example charts generated by the coverageAnalysis plugin
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The charts that are generated by the coverageAnalysis plugin include Plot, Overlay, or Display menus

that allow you to customize the data that is displayed in each chart.

Click Q (Search) (in the top right corner of a chart) to open the chart Viewing Options panel, where

you can further customize a chart. Click ? (Help) to open a description of the chart.

~ Depth of Coverage Chart IFIot: Maximum Read Depth ¥ I Zoom Cut )

Viewing Options: Automatic Zoom: # Show Legend: ¥ Include Ox Coverage: ¥ Bin Size: 1000

el

4.0%

1.0%

0.0%

Bases

Cumulative Bases

20000 30000 40000 50000 60000

Base Read Depth

70000

80000
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=
S
&
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=)

20%

Cumulative Bases

Figure 1 Representative Depth of Coverage Chart

The Depth of Coverage Chart shows the distribution of targeted base coverage. The X-axis represents the base read
depth. The left Y-axis represents the number of reads at a given base read depth or a range (bin) of base read depths, as
a percentage of the total number of base reads. The right Y-axis represents the cumulative count of the number of reads
at a given read depth or greater, as a percentage of the total number of reads. The individual orange bars represent the
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percentage of reads in the specific range of base read depths. The blue curve measures the cumulative reads at a given
base read depth or greater. If your analysis includes a region of interest file, this chart reflects only target regions (reads
that fall within a region of interest). Use the Plot dropdown list to switch between Maximum Read Depth, 99.9% of All
Reads, and Normalized Coverage plots.

Representation Plots ID\splay PassiFail vs. Target GIC Content v I

= Amplicon Representation vs. Amplicon C/G Content
Pass/Over (Assigned Reads >= 5x mean)
Pass

Fail {Assigned Reads < 0.2x mean)

Drop Out (0 Assigned Reads)

a |
2

=]
-
=
]

Number of Amplicons

22 24 26 28 30 32 34 38 38 40 42 a4 46 48 50 52 54 56 58 60 62 64 66 68 70 72 74 76

Amplicon C/G Base Content (%) Y

Figure 2 Representation Plots

Use the Display dropdown list to switch between Pass/Fail vs. Target G/C Content, Pass/Fail vs. Target Length,
Representation vs. Target G/C Content, Amplicon Coverage Chart, Mean Target Reads vs Pool, Reference
Coverage Chart, and Representation vs. Target Length plots. This figure shows an example Pass/Fail vs. Target
G/C Content plot.

Output files generated by the coverageAnalysis plugin

You can download coverageAnalysis plugin results files from links that are contained in the File Links
section.

Sometimes the file name can be too long to open in applications such as Microsoft™ Excel™. To resolve
this problem, right-click the file and click Save As to rename the downloaded file.

Click @ (Help) next to the file to open a description of the file.

The following is an example of the content of a results file that is generated by the coverageAnalysis
plugin.

The list of files depends on the application type selected.

File Description
Coverage A summary of the statistics presented in the tables at the top of the plugin report. The first line
statistics is the title. Each subsequent line is either blank or contains a statistic title followed by a colon (:)
summary and its value.
Base depth of Coverage summary data used to create the Depth of Coverage Chart. This file contains the
coverage following fields:

* read depth: the depth at which a (targeted) reference base has been read.
* base_ cov:the number of times any base was read (covered) at this depth.
®* base cum_ cov: the cumulative number of reads (coverage) at this read depth or greater.

* norm read depth: the normalized read depth (depth divided by average base read
depth).

®* pc base cum_cov:same as base cum_cov but represented as a percentage of the
total base reads.
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(continued)

File

Description

Amplicon
coverage
summary

Coverage summary data used to create the Amplicon Coverage Chart. This file contains these
fields:

contig_id:the name of the chromosome or contig of the reference for this amplicon.
contig srt: the start location of the amplicon target region.

This coordinate is 1-based, unlike the corresponding 0-based coordinate in the original
targets BED file.

contig end: the last base coordinate of this amplicon target region.

Note: The length of the amplicon target is given as tlen = (contig_end - contig_srt + 1).
region id:the ID for this amplicon as given as the 4th column of the targets BED file.
gene_1id: the gene symbol as given as the last field of the targets BED file.
gc_count: the number of G and C bases in the target region. %GC = 100% * gc / tlen.

overlaps: the number of times this target was overlapped by any read by at least one
base.

Individual reads might overlap multiple amplicons where the amplicon regions themselves
overlap.

fwd e2e: the number of assigned forward strand reads that read from one end of the
amplicon region to the other end.

rev_e2e:the number of assigned reverse strand reads that read from one end of the
amplicon region to the other end.

total reads: the total number of reads assigned to this amplicon. This value is the sum
of fwd reads and rev_reads and is the field that rows of this file are ordered by (then
by contig id, srt and end).

fwd_ reads: the number of forward strand reads assigned to this amplicon.
rev_reads: the number of reverse strand reads assigned to this amplicon.
cov20x: the number of bases of the amplicon target that had at least 20 reads.
cov100x: the number of bases of the amplicon target that had at least 100 reads.

cov500x: the number of bases of the amplicon target that had at least 500 reads.

Chromosome
base coverage
summary

Base reads per chromosome summary data used to create the default view of the Reference
Coverage Chart. This file contains these fields:

chrom: the name of the chromosome or contig of the reference.

start: the coordinate of the first base in this chromosome. This is always 1.
end: the coordinate of the last base of this chromosome. Also its length in bases.
fwd reads: the total number of forward strand base reads for the chromosome.
rev_reads: the total number reverse strand base reads for the chromosome.

fwd_ontrg (if present): the total number of forward strand base reads that were in at least
one target region.

seq_reads: the total sequencing (whole) reads that are mapped to individual contigs.
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(continued)

File Description
Aligned reads Contains all aligned reads that are used to generate this report, in BAM format. This is the same
BAM file file that can be downloaded from the main report (for the specific barcode). See the current

SAM tools documentation for more file format information.

Aligned reads BAI | Binary BAM index file as required by some analysis tools and alignment viewers such as IGV.

file

This is the same file that can be downloaded from the main report (for the specific barcode).

(Genexus™ Software version 6.6.0 and later) Copy and edit
an assay

1.

2.

In the menu bar, click Assays » Manage Assays.

In the Manage Assays screen, in the Actions column in the row of an assay that you want to
copy, click Copy.

(Genexus™ Software version 6.2.1 only) Copy and edit an

assay
1.

2.

In the menu bar, click Assays » Manage Assays.

In the Manage Assays screen, in the Actions column in the row of an assay that you want to
copy, click Copy.

In the Copy Assay screen, proceed through the workflow steps. When finished, enter a new name
in the Assay Name field and a short name in the Assay Short Name field for the copied assay,
then click Save.

In the Manage Assays screen, in the Actions column in the row of your copied assay, click Edit,
then in the Edit Assayscreen proceed to the Parameters step.

At the top of the screen in the Parameters step, select Library Prep & Templating Parameters
from the dropdown list, then click Download.

A ZIP folder that contains the RunParameters.json file for the assay is downloaded to your local
storage.

Open the RunParameters.json file using a text editor, then search for “amplifyTargetPCRProfile”.
The following text string should follow the instance of the matched text.

value":"[[[990], [xxx],x],[[990, xxx], [xx,xxx],xx], [ [xxx], [xx],x]]

Replace each instance of the 990 value with 980 in the text string (a total of two instances), then
save the edited RunParameters.json file to your local storage.
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10.

11.

12.

13.

Return to the Edit Assay screen in the Genexus™ Software, then at the top of the screen in the
Parameters step, click Upload.

Under Advanced Parameter Configuration, click Select files, select the edited
RunParameters.json file, then click Open.
When upload is complete, Parameter file uploaded successfully message is displayed.

Proceed through the remainder of the workflow steps, then click Save to save the assay.

In the Manage Assays screen, in the Actions column in the row of your edited assay, click Lock
to lock the assay.

In the Actions column, in the row of your edited assay, click Download Parameters.

Open the RunParameters.json file and verify that the parameter changes from step 7 have been
saved.
Your modified assay is now ready for use in a run.

Create NTC sample

If you are including an NTC sample, you must first create a NTC sample using the same procedure
as any other viral RNA sample. The Include NTC checkbox is not functional for the lon AmpliSeg™
SARS-CoV-2 Insight Research Assay.

1.

2.

100

In the menu bar, click Samples » Manage Samples.
In the Manage Samples screen, click 4 Create Sample.

In the Create Sample dialog box, in the Sample Name attribute, enter NTC_Sample, then
complete the required fields.

IMPORTANT! You must enter NTC_Sample in the Sample Name attribute.

Attributes identified with a red asterisk (*) in the Create Sample dialog box are required when
adding a new sample. If attribute information is not available when adding a new sample,
substitute mock information to complete the required fields.

For more information, see “System-installed sample attributes” on page 31.

Click Save.

The NTC sample is listed in the Manage Samples screen and is available to use in your run. You
can add the sample when planning a run. The results for the NTC sample may be viewed using the
same procedure as any other sample included in the run.
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Create new copy assay for SARS_CoV_2_lineagelD plugin updates

Create new copy assay for SARS_CoV_2_lineagelD plugin
updates

1. In the menu bar, click Assays » Manage Assays.

2. (Optional) Obsolete the copy assay created to include the previous version of the
SARS_CoV_2_lineagelD plugin.

3. Inthe Manage Assays screen, in the Actions column in the row of an assay that you want to
copy, click Copy.

4. Inthe Copy Assay screen, proceed through the workflow steps, on Plugins tab, select the
SARS_CoV_2_lineagelD (only the latest installed version is available for selection). When finished,
enter a new name in the Assay Name field and a short name in the Assay Short Name field for
the copied assay, then click Save.

The modified assay is now ready for use in a run.
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Safety

A WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
' documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.

Genexus™ Integrated Sequencer safety

For detailed safety information for use of the Genexus™ Integrated Sequencer, see the Genexus™
Integrated Sequencer User Guide (Pub. No. MAN0017910).
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with

sufficient ventilation (for example, fume hood).

Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer

cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

A AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION DE PRODUITS

' ' CHIMIQUES. Pour minimiser les risques, veiller a ce que le personnel du laboratoire lise attentive-
ment et mette en ceuvre les consignes de sécurité générales relatives a I'utilisation et au stockage
des produits chimiques et a la gestion des déchets qui en découlent, décrites ci-dessous. Consulter
également la FDS appropriée pour connaitre les précautions et instructions particulieres a respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le fabricant avant de
stocker, de manipuler ou d’utiliser les matériaux dangereux ou les produits chimiques. Pour obtenir
les FDS, se reporter a la section « Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de protection appropriés
lors de la manipulation des produits chimiques (par exemple : lunettes de slreté, gants ou véte-
ments de protection).

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de produits chimiques
ouverts. lls ne doivent étre utilisés qu’avec une ventilation adéquate (par exemple, sorbonne).

. Vérifier régulierement I’absence de fuite ou d’écoulement des produits chimiques. En cas de fuite
ou d’écoulement d’un produit, respecter les directives de nettoyage du fabricant recommandées
dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.
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. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient primaire contient les
déchets immédiats, le récipient secondaire contient les fuites et les écoulements du récipient pri-
maire. Les deux récipients doivent étre compatibles avec les matériaux mis au rebut et conformes
aux exigences locales, nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les applications, les réactifs et
les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et éliminés en res-
pectant toutes les réglementations locales, nationales et/ou communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif exigent parfois une
manipulation spéciale, et des limitations peuvent s’appliquer a leur élimination.

WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.

Biological hazard safety

A
A
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WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document Publication number

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GX Quick Reference MANO0024940

lon AmpliSeg™ SARS-CoV-2 Insight Research Assay — GX Product Information Sheet MANO0024941

Genexus™ Integrated Sequencer User Guide MANO0017910
Genexus™ Software 6.8 User Guide MANO0026409
MagMAX™ Viral/Pathogen Nucleic Acid Isolation Kit (manual extraction) User Guide MANO0018072

MagMAX™ Viral/Pathogen Nucleic Acid Isolation Kit (automated extraction) User Guide MANO0018073

Qubit™ RNA HS Assay Kits User Guide MANO0002327

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.
* Worldwide contact telephone numbers

* Product support information
— Product FAQs
- Software, patches, and updates
— Training for many applications and instruments
* Order and web support
* Product documentation
— User guides, manuals, and protocols
— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.
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Appendix D Documentation and support
Limited product warranty

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the
Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at

www.thermofisher.com/support.
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